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Introduction 
The OTTER System (Oregon Tax Employer Reporting System) allows employers to file Oregon 

Combined Payroll Tax reports by linking the reports electronically to our secure server. You may also use e-
mail or mail us a diskette.  The tax rates will change from year to year.  All businesses will be notified of 
those changes and how to update their system. 
 

This guide contains instructions for the OTTER System.  It does not have complete instructions for the 
quarterly forms.  Please refer to the current Oregon Combined Payroll Tax Report instruction booklet for 
complete instructions on the quarterly forms.   
 
  Computer requirements for the OTTER System include: 

 • Operating system of Windows 98/2000/XP/Vista 
 • A Pentium microprocessor or higher 
 • 128 MB RAM, though 256 MB is preferred 
 • 20MB free space on the system hard drive 

 
To install the OTTER System, please see the Installation Instructions.  After it is installed, use the program 

to create quarterly tax reports, print file copies, and save the data as a transfer file.  The transfer file can be 
sent electronically using our secure server (most reliable), as an e-mail attachment over the Internet or by 
mailing the file to us on a 3.5” diskette.   
 

File copies are not intended for submitting tax information.  Do not send the printed reports to the 
Employment Department.  The printed reports are to be used for employer's records only. 
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Quick Step Page 
From the menu bar select File, then Save (or use the F2 key) after editing existing information or adding new 
information. 

First Time Use 
1. In Windows 98/2000/XP/Vista, select the OTTER32 item from the Start menu under 

Programs/OTTER32 System.  The Startup Wizard will appear. 
 
2. To enter all new data, follow the Startup Wizard instructions. 
 
3. To add further information, please follow the instructions listed below. 
 

Add Information to an Existing System 
1. Add a new business, or select an existing business, and complete the Business Information form.  For 

further information see Business Information. 
 
2. Add a new year to the business, or select an existing year, and complete the Default UI Tax Rate 

Information form.  For further information see Default UI Tax Rate Information. 
 
3. Add a new quarter, or select an existing quarter, and complete the Quarterly Information form.  For 

further information see Quarterly Information. 
 
4. Complete the Form 132.  For further information about Form 132, please see Form 132. 
 
5. If required, complete the Schedule B form. For further information about Schedule B form, please see 

Schedule B Form. 
 
6. Complete the Form OQ.  For further information about Form OQ, please see Form OQ. 
 
7. Select Validate Quarter from the File menu on the menu bar to validate the quarter.  For further 

information, see How to Validate a Quarter or Mass Validate.  Transfer files can only be created for 
validated quarters. 

 
8. If the quarter does not pass validation make corrections to the incorrect data entries until it does pass. 
 
9. To prepare the file to transmit by secure server, e-mail or diskette, select Make Transfer File from the 

File menu on the menu bar.  For further information, see How to Make a Transfer File.  Transfer files can 
only be created for validated quarters. 

 
10. Print copies of reports for your files if desired. 
 
11. To add more information to the system, repeat steps 1 through 9. 
 
12. Send the Reports to the Oregon Employment Department using ONE of the following methods: 
 
 

A.) Send reports electronically using the Employment Department secure server (most reliable). For 
further information, please see Transfer File by Secure Server. Or 

 
B.)  send reports electronically as an e-mail attachment to the Employment Department. 

For further information, please see Transfer File by E-mail. 
E-mail address for the Oregon Employment Department: 

 
OTTER@emp.state.or.us . Or 

 
 
 
 
 

mailto:OTTER@emp.state.or.us
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C.)  mail reports on a 3.5” diskette to the Employment Department. 

For further information, please see  Send Reports on Diskette. 
Oregon Employment Department address: 

 
Oregon Employment Department 
Tax Section - OTTER 
875 Union St NE 
Salem OR  97311-0030 

 
 

13. Send PAYMENTS with completed Form OTC to the Oregon Department of Revenue. 
Oregon Department of Revenue address: 
 

Oregon Department of Revenue 
PO Box 14800 
Salem OR 97309-0920 

 
PLEASE… 
DO NOT SEND DISKETTES TO THE OREGON DEPARTMENT OF REVENUE!!!! 
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Installation Instructions 
Please close all applications, including Office toolbars and virus scanning software, before starting the 
installation process for the OTTER System.  If a message is displayed that another program is running, shut 
it down. 
 
Windows 98/2000/XP/Vista users can press CTRL+ALT+DEL to see what programs are running.  The 
Explorer should be the only program running.  Any other applications need to be shut down.   
 

Installation from the Internet 

 To download the OTTER System from the Internet, go to 
http://oregon.gov/EMPLOY/TAX/OTTERhome.shtml . 

 There are instructions on how to download and setup the OTTER System. 
 

Installation Using CD 

 Insert CD into the CD/DVD drive. 

 Follow instructions on the screen. 

 Double-click on the OTTER System icon              to start the OTTER System. 

http://oregon.gov/EMPLOY/TAX/OTTERhome.shtml
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Preparer Instructions 

• Please review all instructions before submitting reports. 

• Thank you for using the OTTER System.  Following these guidelines can assist us in ensuring a 
smoother process for preparing and filing quarterly reports. 

• If there are problems with OTTER, please review the instructions in this booklet for answers, use the 
online help, or look on the Internet at http://oregon.gov/EMPLOY/TAX/OTTERhome.shtml and review 
the FAQ section for similar problems.  Please look for the answer in these locations before contacting 
the Employment Department for technical assistance. 

• Do not include reports previously submitted.  For example, do not send the 1st quarter, 2nd quarter or 
3rd quarter reports when only needing to file the 4th quarter's report. 

• The secure server is the quickest and most reliable method of submitting the transfer file to us. 

•  When submitting by e-mail, if the sent message was unsuccessful, a return message will be sent 
saying there was a problem.  Check the address.  It should say: OTTER@emp.state.or.us .  Try to send 
the file again by attaching OTTERTRF.ZIP to a new e-mail message. If it fails to reach us twice, please 
use the secure server process. 

• When submitting a diskette, please print your name, phone number, number of quarterly reports and 
number of firms reported, on the diskette label. 

 
 
Please Read Section 

If You Don't Read Anything Else, PLEASE READ THIS! 
• Complete the forms in the following order: Form132, then Schedule B, then Form OQ.  Calculated totals 

from Form 132 and Schedule B automatically flow to form OQ.   

• The OTTER System is not intended to make printed reports.  The print options provided are to create a 
hard copy for employer's records only. 

• Some of the fields in this program use your system's default color to indicate they calculate 
automatically and data cannot be entered into these fields.  Fields that are required are by default 
colored green.  This color may be changed by the user.  The white fields are optional. 

• Please remember, when entering information into OTTER, if changes have been made to data fields, 
Save must be selected in order to move to another form. 

• Save data often.  Select the Save button on the toolbar, Save from the File menu, or press the F2 key 
on the keyboard. 

• The following is an explanation for each button on the Toolbar:  

 
  New        Add       Delete    Save      Copy    Validate   Print    Print    Search    Sort 
 Business                                            Quarter  Quarter              Preview 
 
 To see a description of a button while working in the OTTER System, place the cursor over the button for a 

couple of seconds and a description will appear. 
 

http://oregon.gov/EMPLOY/TAX/OTTERhome.shtml
mailto:OTTER@emp.state.or.us
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Startup Wizard 
For first time users, the OTTER System is designed to initialize a Startup Wizard.  It walks the user through 
setting up their first business and the default settings for their system. 
 

 
How to Use the Startup Wizard 

 Select Next to bring up the next screen in the Startup Wizard. 

 The next Startup Wizard screen will appear. 

 Select Finish to exit out of the Startup Wizard and go directly into the system. 

 This option is available at every step of the Startup Wizard, but we recommend you continue on through the 
Startup Wizard. 

 Select Cancel to exit out of the Startup Wizard and to exit out of the OTTER System. 

 This option is available at every step of the Startup Wizard. 
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 Enter the name of the business in the Name field. 

 This field cannot be left blank. 

 Enter the Business ID Number (BIN) and Federal EIN in the appropriate fields. 

 These fields cannot be left blank. 

 Enter the business's address, city, state, zip and country information in the appropriate fields. 

 Select Back to return to the previous Startup Wizard screen. 

 Select Next to bring up the next screen in the Startup Wizard. 

 The next Startup Wizard screen will appear. 

 

 Enter the first year to start entering data for the business. 

 Select the quarter to start entering data for the business.  

 Select Back to return to the previous Startup Wizard screen. 

 Select Next to bring up the next screen in the Startup Wizard. 

 The next Startup Wizard screen will appear. 
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 Enter the Default Unemployment Insurance Tax Rate. 

 The new year’s tax rate is mailed by the Employment Department in November of the previous year. 

 Select Back to return to the previous Startup Wizard screen. 

 Select Next to bring up the next screen in the Startup Wizard. 

 The next Startup Wizard screen will appear. 
 

 
The information entered on this Startup Wizard screen will default as the preparer information for any 
quarters added in the future.  This information may be changed by selecting Options from the File menu.  
See How to Change the Default Preparer Information for further information. 

 Enter the first name, middle initial and last name of the preparer in the appropriate fields. 

 Enter the name of the company that the preparer represents in the Company field. 

 Enter the company's address, city, state, zip and country in the appropriate fields. 
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 Enter a phone number for the preparer in the Phone field. 

 Enter a fax number for the preparer in the Fax field. 

 Enter an e-mail address for the preparer in the Email field. 

 Select Back to return to the previous Startup Wizard screen. 

 Select Finish to exit out of the Startup Wizard and go directly into the system. 

 Select Next to bring up the next screen in the Startup Wizard. 

 The next Startup Wizard screen will appear. 

 

 Select Back to return to the previous Startup Wizard screen. 

 Select Finish to exit out of the Startup Wizard and go directly into the system. 



 10

Main Screen 
 

 
  
The OTTER System's main screen consists of a menu bar, a toolbar, a left panel, a separator bar, a right panel, 
and a status bar.  
 
 The menu bar is located at the top of the main screen.  It includes a File menu, a List menu, a 
Documents menu, and a Help menu.  
  
The File menu includes New Business, Add Year, Add Mass Year/Quarter, Copy Quarter, 
Delete, Save, Print Preview, Print, Validate Quarter, Mass Validate, Make Transfer 
File, View Transfer File, Utilities, Options, Backup/Restore and Exit. 
 
The List menu includes Search and Sort.   
 
The Documents menu includes links to Acrobat Reader documents Form013 (Change in Status Report), 
Form WR, and Oregon Combined Payroll Tax Report. 
 
The Help menu includes Contents, Search for Help on…, Technical Support, System Information, and 
About. 
 
When Form 132 or Schedule B screens are active, you can see one more option on the menu bar – the 
Format Grid menu. 
 
Note: If no information is entered yet in to the Otter32 system, only New Business, Options, 
Backup/Restore and Exit menu options are available under the File menu, and Add New Business button 
on the toolbar. 
 
 The toolbar is located at the top of the main screen, just below the menu bar.  It consists of several 
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buttons that perform the same functions as the items listed on the menu bar.  
 
 The left panel is located on the left side of the screen and contains a list of the business information in 
tree/list form. 
 
 The separator bar is a vertical bar dividing the left and right panels. 
 
 The right panel is located on the right side of the screen and contains varying information depending on 
the item that is selected in the left panel. 
 
 The status bar is located at the bottom of the main Otter screen.  This contains a message section and a 
date/time section. 
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Menu Bar 
Go to Main Screen 

 
File Menu  
 New Business  – Add a new business to the list. 
 
 Add Year  – Add a new year to the selected business. 
 
 Add Mass Year/Quarter - Add a specified year to one or more businesses. 
 
 
 
 Add Quarter  – Add a new quarter to the selected year of the selected business. 
  Quarter 1  – Add Quarter 1 
  Quarter 2  – Add Quarter 2 
  Quarter 3  – Add Quarter 3 
  Quarter 4  – Add Quarter 4 
 
 Copy Quarter     – Copy Form132 SSN's and names from one quarter to another.  This option creates new 

quarter for selected record(s).  If the destination quarter already exists, any SSN’s that 
do not exist will be added.  Existing SSN’s will not be added. 

 
 Delete   – Delete the selected business, year, or quarter. 
 

 Save   – Save changes made to forms.  This option is available only after changes have been 
made. 

 
 Print   – Print the selected report (Form 132, Schedule B, and Form OQ).  If a quarter is 

selected then all three reports are printed. 
 Print Preview – Preview the selected report (Form 132, Schedule B, and Form OQ).  If a quarter is 

selected then all three reports are previewed. 
 

Preview List of Accounts – Preview the List of Accounts report with the information about all the 
businesses in the Otter32 system.  The report contains Business ID, Business 
Name, Quarter, Year, and indicates whether or not reports were validated and sent 
to a transfer file.  

 
 Print List of Accounts – Print the List of Accounts. 
 

 Validate Quarter – Verify the selected quarterly reports.  This must be completed before the report can be 
sent in to the Oregon Employment Department. 

 
Mass Validate – Verify the selected quarterly reports for multiple quarters, for one business or multiple 

businesses. 
 

 Make Transfer File – Create the file that transmits the reports to the Oregon Employment Department. 
 
 View Transfer File – Display the list of reports that the selected transfer file contains. 
 
 Utilities 
  Import Form 132 Data – Allows a user to import wage detail information into the currently selected 

Form 132. 
  Export Form 132 Data – Allows a user to export wage detail information from the currently selected 

Form 132. 
  Import Schedule B Data – Allows a user to import Schedule B information into the currently selected 

Quarter/Schedule B. 
  Import Form OQ Data       – Allows a user to import Form OQ information into the currently selected 

Quarter/Form OQ.         
   
  Multiple Business Form Imports 
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   Multiple Business Form 132 Import   – Allows a user to import wage detail information for one 
or more Businesses/Quarters. 

   Multiple Business Schedule B Import   – Allows a user to import Schedule B information for one 
or more Businesses/Quarters. 

   Multiple Business Form OQ Import – Allows a user to import Form OQ information for one or 
more Businesses/Quarters. 

 Options 
  Default Colors – Allows setting the colors that display in required fields. 
  Default Preparer Information – Allows entry/edit of the default preparer information.  This 

information will be pre-filled into the quarterly preparer information 
form that is displayed when a quarter is selected. 

 
  Backup/Restore - Allows a user to backup, archive, and restore Otter data. 
 
 
 
 Exit  – Close OTTER. 
 

List Menu 
  Search – Search the tree for a business (by ID or Name). 
  Sort – Set the order that the tree list displays the businesses, years, and quarters. 
 
Format Grid Menu 
Format Grid menu is visible only when Form 132 or Schedule B forms are displayed. 

Font – Change color and size of the text in the grid(s) on the Form 132 and Schedule B forms. 
 Background – Change background in the grid(s) on the Form 132 and Schedule B forms. 
 
Documents Menu 
Documents menu allows a user to select the following Acrobat Reader documents: Form013 (Change in 
Status Report), Form WR, and Oregon Combined Payroll Tax Report. 
These documents are also available under Start -> Programs -> Otter32 System -> Document. 
Note: Acrobat Reader has to be installed in order to view the above documents. 
 

Help Menu 
  Contents    – Display Help Contents. 
  Search for Help on... – Display Index of available help information. 
  Technical Support  – Display technical support information. 
  System Information – Information about user (if available), computer, CPU type and memory. 
  About Otter   – Display the Version information of OTTER. 
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Tool Bar 
 

  New Business   – Add a new business to the list. 
 

  Add  – Add a new Year if a business is selected.  Add a new Quarter if a year is selected. 
 

  Delete   – F4 – Delete selected Business, Year, or Quarter. 
 

 Save   – F2 – Save modified data.  If this icon is colored, then there is information that 
needs to be saved. 

 

  Copy Quarter  – Copy Form 132 SSN's and Names from one quarter to another. 
 

  Validate Quarter – F12 – Cross match the three forms to verify that required information is entered 
correctly.  This is required before quarterly report can be transferred. 

  Print   – Ctrl+P – Print selected report. Prints all three reports if quarter is selected. 
 

  Print Preview  – Ctrl+R – Preview selected report. Previews all three reports if quarter is selected. 
 

  Search – F3 – Search list for desired Business/Year/Quarter. 
 

  Sort – Sort list by Business (ID or Name), Year, Quarter ascending or descending. 
  
 
 

Left Panel 
The left panel displays business information in a collapsible directory/outline format.   
 
The different levels in the outline may either be expanded or collapsed using one of three methods. 
•  double click the left mouse button on a folder or the item listed to the right of a folder 
   - or - 
• click on the plus (+) or minus (-) next to an item 
   - or - 
• Keyboard method: If an item in the outline is highlighted (must be the active item - normally background 

is blue), the user may select the plus (+) key to expand the outline or the minus (-) key to collapse the 
outline. 

 
 

Separator Bar 
The separator bar is used to adjust the relative sizes of the left and right panels.  To adjust these 

sizes, drag the mouse pointer over the separator bar until the mouse pointer changes, click and hold the 
left mouse button, drag the separator bar left or right to change relative sizes of the panels. 
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Right Panel 
 The right panel may contain one of the following items depending on the selection in the left panel: 
 
 left panel right panel 
 Business ID/Name Business Information 
 Year Default UI Tax Rate 
 Quarter Preparer Information 
 Form 132 Wage Detail Information 
 Schedule B Daily Withholding Information 
 Form OQ Oregon Quarterly Tax Form 
 
 
Status Bar 

 The status bar, located at the bottom of the Otter main form, is used to display error messages and 
other user information on the left portion.  The right end of the status bar displays the current date and 
time. 
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Business Information 
The Business Information form is displayed on the right panel when a business name in the outline on 

the left panel has been selected.  This form contains the name, Business ID, Federal EIN and address 
information for the selected business.  Data on this form may be edited whenever it is displayed.  The File 
menu and toolbar provide options to Delete and Save business information. 
 

 
 

For further information, please see the following: 
• How to View Business Information 

• How to Add a New Business 

• How to Edit Business Information 

• How to Delete Business Information 

• How to cancel Adding a new Business 
 

Business Name - Required 
The business name is the name of the company for which this report is being filed.  The business 

name should be entered with no leading spaces and spelled exactly as it appears on legal documents. 
 
 
Business ID - Required 

The Oregon Business ID is the identification number assigned to you by the State of Oregon.  The 
Business ID consists of two parts: a seven-digit account number and a one digit check digit.  This ID 
number consists of all numeric characters. 
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Federal ID - Required 

The Federal ID is the identification number assigned by the federal government.  This identification 
number is 9 numeric characters usually presented in the form of two digits, a dash, and seven digits. 

 
 
Business Address 

The business address is the address of the business for which this report is being filed.  This 
address represents the address assigned to the business by which the company can be contacted via 
US POSTAL service. 

 
Optional - entry is not required however it is requested.  
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How to View Business Information 

 To view the address information for a particular business, click on its name and Business ID Number 
(BIN) in the outline on the left panel of the main screen. 

 Fields can be edited any time the account information is shown. 
 
 
How to Add a New Business 

 Select New Business from the File menu or the New button from the toolbar at the top of the screen. 

 Enter the name of the business in the Name field. 

 This field cannot be left blank. 

 Enter the Business ID and Federal EIN in the appropriate fields. 

 These fields cannot be left blank. 

 Enter the business's address, city, state, zip and country in the appropriate fields. 

 To save the new business information, select Save from the File menu or the toolbar at the top of the 
screen. 

 
 
How to Edit Business Information 

 To edit the address information for a particular business, click on its name and Business ID number 
(BIN) in the outline list on the left panel of the main screen. 

 Some fields will be a different color.  Colored fields cannot be left blank.  To change the color of the required fields 
see How to Change Colors. 

 Modify the values in all appropriate fields. 

 To save changes, select Save from the File menu or from the toolbar at the top of the screen. 
 
 
How to Delete Business Information 

 To delete the address information for a particular business, click on the name and Business ID number 
(BIN) in the outline list on the left panel of the main screen. 

 Select Delete from the File menu or the toolbar. 
 Deleting a business will cause all of the years and quarterly information related to the selected business to also be 

deleted. 
 
 

How to Cancel adding a New Business 
 

To cancel adding a new business, press the Esc key (twice if you have already keyed some 
information).  A prompt asking: "Do you want to abort adding a new Business?"  is displayed.  Click the Yes 
button to abort, click the No button to continue adding the business.   

 
You can cancel the New Business add any time prior to saving. 
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Default UI Tax Rate (Yearly Information) 
The Default UI Tax Rate form is displayed on the right panel when a year in the outline to the left is 

highlighted.  This form contains the Default Unemployment Insurance Tax Rate for the year selected.  The 
default yearly rate is the tax rate used for all new quarters added, but it will not change any existing quarter 
data.  When first brought up, the data on this form may be modified.  The File menu and toolbar provide 
options to Delete or Save. 
 

 
 
For further information, please see the following: 
• How to View Default UI Tax Rate Information 

• How to Add a New Year 

• How to Add Mass Year/Quarter 

• How to Edit Default UI Tax Rate Information 

• How to Delete a Year 

 
 
Default Rate 

The default rate should contain the Unemployment Insurance tax rate that was assigned to the reporting 
business by the Oregon Employment Department for the selected year.  

This rate will be pre-filled in the Form OQ UI tax rate field for any quarters added after this value is set.  
Existing quarters are not changed when this value is modified. 

Reimbursing employers should set this value to zero (0).  LGEBTF employers may need to change this 
value in July if their rate has changed. 
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How to View Default UI Tax Rate 

 To view the Default Unemployment Insurance Tax Rate for a particular year; click on the year listed 
under a selected business from the outline on the left panel. 

 Fields can be edited any time the Default UI Tax Rate form is displayed. 
 
 
How to Add a New Year 

 Select the business for which the new year will be added from the outline on the left panel. 

 Select Add Year from the File menu or toolbar. 

 The Add Year dialog box will appear. 

 
 Enter a four-digit year into the blank field. 

 Press the OK button to add the year to the selected business. 

 If the Cancel button is selected, the addition of the new year will be cancelled. 

 Enter the Default Unemployment Insurance Tax Rate for the new year. 

 The default yearly rate is the tax rate used for all new quarters added, but it will not change any existing quarter 
data.  Reimbursing employers should set the rate to zero; Local Government Employers Trust Fund employers 
should change the default rate for third quarter if the rate changed on July 1. 

 Select Save from the File menu or the toolbar. 

 To add a year and a quarter to one or more businesses at the same time, use the Add Mass 
Year/Quarter option under the File menu. 
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Add Mass Year/Quarter 
 

 Click File menu and select Add Mass Year/Quarter. The Add Mass Year/Quarter form will appear. 
Year and Quarter fields will be pre-filled with current year and quarter, or you 
can enter a specific year and quarter you would like to create. 
 

 All the businesses that do not have the specified year and quarter will be listed. 
 

 
 

 Click the Select All button to select all the businesses. 
 

 The list of businesses that do not have the specified year and quarter will be refreshed. 
 

 Click the Create Year/Quarter button to add specified year and quarter to the selected businesses. 
 

 NOTE: Preparer’s information must be complete when adding mass Year & Quarter. 
 

 After the specified year and quarter is added to the selected business(es), the list of businesses is 
refreshed. 

 
How to Edit Default UI Tax Rate Information 

 To edit the Default Unemployment Insurance Tax Rate for a particular year, select the year from the 
outline on the left panel. 

 Change the tax rate to the correct amount. 

 To save changes, select Save from the File menu or the toolbar. 

 
 
How to Delete a Year 

 Select the year to be deleted from the outline on the left panel. 

 Select Delete from the File menu or the toolbar. 

 The Confirm Delete dialog box will appear.   
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 Select the Yes button to delete the year or No to cancel the deletion. 

 Selecting Yes will delete ALL of the Quarterly information for the selected year / business. 
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Quarterly Information 
The Quarterly Information form contains information about the person who prepared the selected 

business's tax information for the selected quarter.  It includes the individual's name, the company they 
represent, address information, a phone number and the date the quarterly information was prepared.  The 
quarterly information may be modified any time the quarterly information form is displayed.  The file menu 
and toolbar provide options to Delete or Save the quarterly information. 
 

 
 
For further information please see the following: 
• How to View Quarterly Information 

• How to Add a New Quarter 

• How to Add Mass Year/Quarter 

• How to Edit Quarter Information 

• How to Delete Quarter Information 

• How to Copy a Quarter 

• How to Validate a Quarter 

 
Quarterly Info 

The quarterly information form contains the preparer information.  This information is used by the 
Oregon Employment Department to make contact with the preparers when necessary.  New releases of 
the OTTER program are shipped using the preparer information. 
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Having consistent information for an individual preparer is important to ensure correct mailings with a 

minimum number of duplicate copies. 
 
 
NOTE! - The preparer information pre-fills from the Default Preparer Information when a new quarter is added. 
Preparer Name 

 The preparer name is the name of the person who is filling out the selected report.  The preparer 
name consists of three parts: 

1.  First Name - Required 
2.  Middle Initial - Optional 
3.  Last Name - Required 

 
Preparer Company - Required 

The preparer company name is the name of the company that employs the person preparing the 
selected report.  This may be the name of the person preparing the report. 

 
Preparer Address Line 1 - Required 

The preparer address is the mailing address of the person/company preparing the selected report.    
 
 
Preparer Address Line 2 - Optional 

If the mailing address of the preparer has more than one line, the second line of the preparer 
address allows entry of the additional address information. 

 
Preparer City - Required 

The preparer city is the city of the mailing address of the person/company preparing the selected 
report.  

 
Preparer State - Required 

The preparer state is the state abbreviation of the mailing address of the person/company preparing 
the selected report. 

 
 
Preparer Zip Code - Required 

The preparer zip code is the zip code of the mailing address of the person/company preparing the 
selected report. 

 
Preparer Country – Required 

The preparer country is the country of the mailing address of the person/company preparing the 
selected report. 

 
Preparer Phone - Required 

The preparer phone number is the phone number of the person/company preparing the selected 
report. 

 
Preparer Fax - Optional 

The preparer FAX number is the FAX number of the person/company preparing the selected report. 
 
Preparer Email - Optional 

The preparer Email is the Email address of the person/company preparing the selected report. 
 
Date Prepared - Required 

The date prepared is the date that the selected report is prepared.  This date pre-fills with the current 
system date when the quarter is added.  Date may be entered in any standard date format.  Assumes 
current century if no century is entered.  Default format mm/dd/yyyy. 
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How to View Quarterly Information 

 To view quarterly information, double-click on a year listed under a business from the outline on the left 
panel. 

 Click on a quarter listed under the selected year in the outline. 

 The Prepared By information for the selected quarter will appear. 
 
 
How to Add a New Quarter 

 Use Add Quarter if you are going to import data from a payroll system. 

 Do not add a new quarter if you are going to use the Copy Quarter option to copy information from 
another quarter. 

 Select a year listed below a business from the outline on the left panel. 

 Select Add Quarter from the File menu or from the toolbar. 

 If selecting New Quarter from the toolbar, the next sequential quarter for the selected year will be added, whereas, 
selecting Add Quarter from the File menu provides a choice of which quarter to add. 

 Select the appropriate quarter. 

 The default Prepared By information will appear.  To make modifications see How to Change the Default Preparer 
Information.  For each new quarter added, a new set of forms (Form 132, Form OQ, and Schedule B) will appear 
in the outline on the left panel. 

 To save the Prepared By information, select Save from the File menu or from the toolbar. 
 
 
How to Edit Quarter Information 

 Select the quarter to be modified from the outline on the left panel. 

 Some fields will be a different color.  Colored fields cannot be left blank.  To change the color of the required fields, 
see How to Change Colors. 

 Modify the values in all appropriate fields. 

 To save changes, select Save from the File menu or from the toolbar. 
 
How to Delete Quarter Information 

 To delete a quarter, select the quarter from the outline on the left panel. 

 Deleting a quarter will delete the Form 132, Form OQ, and Schedule B forms listed under the selected quarter. 

 Select Delete from the File menu on the menu bar at the top of the screen or click the delete button on 

the toolbar. 

 The Confirm Delete dialog box will appear.   

 Select the Yes button to delete the quarter or No to cancel the deletion. 

 Selecting Yes will delete ALL of the Quarterly information for the selected Quarter / Year / Business. 
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How to Copy a Quarter 

 Select Copy Quarter from the File menu or from the toolbar. 

 The Copy quarter dialog box will appear. 

 Enter the year and quarter from which the information will be copied. 

 Press the Next button. 

 Enter the year and quarter to which the information will be copied. 

 Press the Next button.  

 A list of businesses that have the From Quarter will appear. 

 Select all businesses for which the quarter information will be copied. 

 If a business has the quarter to copy to, the information to be copied will be added if the SSN does not already exist 
in the destination quarter.  If the SSN already exists it will not be copied. 

 Press the Finish button. 

 NOTE: Preparer’s information must be complete when copying a quarter. 
 
How to Validate a Quarter 

Reports must be validated before creating a transfer file.  They will not validate if any required fields on 
the Preparer form are blank. 

 Select the quarter to be validated (or one of the associated forms) from the outline on the left panel. 

 Select Validate Quarter from the File menu or the toolbar. 

 The Validate Quarter dialog box will appear. 

 Select the OK button. 

  

 The Validate Quarter dialog box includes a Results and a Solution box.  If any problems are found in 
the prepared reports for the selected quarter, they will be displayed as errors or warnings in the Results 
box.  To see a solution to a problem found, click on the error or warning line and the solution will be 
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displayed in the Solution area of the Validate Quarter Screen.  If the forms have been prepared 
correctly, a "Validation Complete" message will appear in the Results box. To preview a report 
containing results and solutions, click Preview Results/Solution button. 

 To preview a report containing results and solutions, click Preview Results/Solution button. 

 
Mass Validate 
 
Mass Validate option allows verifying the multiple quarterly reports for multiple businesses. 

 Select Mass Validate from the File menu on the menu bar. 

 The Mass Validate form will appear.   

 
 

The Account Selection List shows only the year(s)/quarter(s) for all the businesses that are not 
validated and not reported yet.  The number of the reports that are not validated is shown under the 
Reports Not Validated label. 
Records in the grid are sorted by year, then by quarter in a descending order.  To change the way the 
information is sorted, click on a column heading.  
 

 Select a record or multiple records in the grid. You can click Select All button to select all the records in 
the grid. 

 
 Click on the Validate button.  
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The results of the validation will be displayed in the Results list.  To see a solution to a problem found, 
click on the error or warning line and the solution will be displayed in the Solution area.  If the forms 
have been prepared correctly, a "Validation Complete" message will appear in the Results box. 
The records that passed the validation go off the list leaving only those records that did not pass the 
validation or were not selected for the validation. 
 

 
 

 Click on the Preview Results/Solution button to preview a report with the results of the validation. The 
report contains what you see in the Results box, along with the corresponding Solution line.  
Note: If a check box Warnings & Errors only is checked, the feedback report will contain only the 
records that have warnings and/or errors, and their solutions.  You can print it out and use that 
information to locate business/year/quarter that needs to be fixed. 
 

 Clicking on the Clear Results button will clear the Results list. 
 
Form 132 - Employee Detail Report 

This form is used to report social security numbers, names, hours, total wages for each employee, and a 
sum of the total hours and total wages for the selected business.  This table can be sorted by any of the 
columns by clicking on the column title. The information on this form may be modified any time it is 
displayed.  The File menu and toolbar provide options to Save and Print Form 132. 

 
Complete this form only if reporting wages subject to State Unemployment Insurance.  If subject to State 

Unemployment Insurance and there is no payroll to report for the quarter, do not complete this form. 
 
Do not enter "credit" amounts or negative amounts on Form 132.  If a person was overpaid or incorrectly 
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paid in a previous quarter, use the procedure for filing an amended report for the quarter in which the 
payment was originally paid (see the current year's Oregon Combined Payroll tax report instruction booklet). 

 
The numbers of hours reported on Form 132 do not need to equal the number of hours reported for 

Workers' Benefit Fund.  The two programs do not necessarily cover the same hours of individuals.  Form 132 
is only for hours of work subject to unemployment insurance. 
 

 
 
For further information please see the following: 
• How to View the Form 132 Information 

• How to Add a New Form 132 

• How to Edit Form 132 Information 

• How to Delete a Form 132 

• How to Delete an Employee from Form 132 

• How to Preview and Print Form 132 Report 

• How to Customize a Grid on the Form 132 form  

Importing Form 132 Data: 

• Form 132 Importing 

• Multiple Business Form 132 Importing 
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Form 132 – the Employee Detail Report 
If your business is subject to Oregon Unemployment Insurance (UI) tax, use this form to report 

employee detail.  File this form with Form OQ. 
 
Form 132 Title 

The title bar of the Form 132 indicates to which quarter/year/business that this Form 132 is related. 
 
Form 132 SSN - Required 

The employee's SSN is legal social security number of the employee.  This number is entered as 
nine digits with leading zeros (0) when needed.  The SSN will display like 123-45-6789. 

 
Form 132 Last Name - Required 

The last name column contains the legal last name of the employee.  The last name must be at least 
two (2) characters starting with a letter.  Acceptable characters in the last name column are: a - z, A - Z, 
hyphen (-), space (  ), and apostrophe (').  All other characters are not allowed. 

 
Form 132 First Name - Required 

The first name column contains the legal first name of the employee.  The first name must be at least 
one (1) character starting with a letter.  Acceptable characters in the first name column are: a - z, A - Z, 
hyphen ( - ), space (  ), and apostrophe ( ' ).  All other characters are not allowed. 

 
Form 132 Middle Initial - Optional 

The middle initial column contains the legal middle initial of the employee.  The middle initial is 
optional, but if entered must be a letter.  Acceptable characters in the middle initial are: a - z, A - Z.  All 
other characters are not allowed. 

 
Form 132 Hours 

The hours column contains the number of hours worked by the employee that were subject to UI 
taxes. This field is a number between 0 and 999 and must be entered as a whole number (e.g. 125.3 is 
entered as 126).  Negative numbers are not allowed.  Numbers greater than 999 should be entered as 
999. 

 
Optional - but must be entered if available.  A penalty assessment may be levied if not entered when 

needed. 
 

Form 132 Wages Paid 
The wages paid column contains the total wages paid to the employee during the selected quarter.  

Negative numbers are not allowed.   
 

Optional - but must be entered when available.  A penalty assessment may be levied if not entered 
when needed. 

 
Form 132 Employee ?? of ?? 

This indicates the current employee and the total number of employees currently entered into the 
Form 132.  This is informational only. 

 
Form 132 Total Hours 

Total hours is the total of the hours column.  This is informational only.  The total hours does not 
necessarily indicate the number of hours needed in the Workers' Benefit Fund form. 

 
Form 132 Total Wages 

The total wages is a sum of the Wages Paid column.  This figure will be entered into the UI Subject 
Wages entry of the Form OQ if it is greater than zero. 

 
Form 132 Record Selector 

The record selector portion of the Form 132 screen is used to select employees for deletion from the 
form.  Clicking the record selector next to an employee will select (highlight) that row of the form, 
pressing the delete key on the keyboard will then delete the selected employee from the list. 
 
There are two methods of selecting multiple employees: 
1. Select the first employee as described above, then while holding down the Shift key on the keyboard, 

select the last contiguous employee.  This will select (highlight) a continuous group of rows. 
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2. Select the first employee as described above, then while holding down the Ctrl key on the keyboard, 

select additional employees.  This will highlight only those rows that were selected.   
 

 
Form 132 Scroll Bar 

The scroll bar is used to bring additional employees into view if more than one screen of employees 
are entered into the Form 132.  

 
 
 

How to View the Form 132 Information 
 To view Form 132 information, select the Form 132 line under a selected quarter, from the outline on the 

left panel. 

 To change the way the information is sorted, click on a column heading once to sort the information in 
ascending order, twice to sort the information in descending order. 

 The information will be sorted by the column that is selected and clicked on. 
 
How to Add a New Form 132 
Every time a new Quarter is added, a new Form 132 is created.   

 Add a new quarter to the outline. 
 A new quarter must be added in order to have a new Form 132.  See How To Add A New Quarter. 

 Select the Form 132 listed under the newly added quarter in the outline on the left panel. 

 Import data from another file into the Form 132. 
 For more information about Importing data, see Form 132 Importing. 

 If not importing from another file, Enter each employee's social security number, first name, last name 
and middle initial into the appropriate columns. 

 When entering SSN numbers, if it is a number that has been used before, the name fields will automatically be filled 
in with the previously used information. 

 If not importing from another file, enter hours worked for each employee. 
 Refer to the current year's Oregon Combined Payroll Tax Report instruction book for information to determine 

what to report.   

 If not importing from another file, enter the total wages, for the quarter, for each employee. 
 Include all payments, even if they will be considered "excess" in box 2A on Form OQ. 

 To save the new Form 132 information, select Save from the File menu, from the toolbar, or set the 
cursor on a different row in the table. 

 If the cursor is moved from a selected row to a different row, changes in the originally selected row are 
automatically saved. 

 The value in the Total Wages field will automatically be calculated and copied to box 1A on the Tax Information 
tab on the Form OQ. 

 
 See Multiple Business Form 132 Import to import data for multiple businesses/quarters. 
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How to Edit Form 132 Information 
 Select the Form 132 to be modified from the outline on the left panel. 

 A line for entering data will appear.  You cannot enter an employee into the middle of the form, they must be 
entered in the blank line that appears on the bottom. The information can be sorted by clicking on the column 
heading by which to sort. 

 Enter each employee's social security number, first name, last name and middle initial into the 
appropriate columns. 

 When entering SSN numbers, if it is a number that has been used before, the name fields will automatically be filled 
in with the previously used information.  Enter the middle initial where applicable. 

 Enter hours worked for each employee. 
 When entering the hours, list only whole hours by rounding up any partial hours.  Refer to the current year's Oregon 

Combined Payroll Tax Report instruction book for information to determine what to report.   

 Enter the total wages, for the quarter, for each employee. 
 Include all payments, even if they will be considered "excess" in Item2 on Form OQ. 

 To save changes, select Save from the File menu or from the toolbar. 
 

How to Delete a Form 132 
The selected quarter that the Form 132 is listed under must be deleted in order to delete a Form 132.  See How to Delete 
Quarter Information. 

 

How to Delete an Employee from Form 132 
 Click the selection box to the left of the SSN. 

 The entire row will be highlighted. 

 To select multiple consecutive employees, select the first row to be deleted, and while holding down the 
Shift key on the keyboard, select the last row to be deleted.  All the rows in between will be highlighted. 

 To select multiple non-consecutive employees, while holding down the Ctrl key on the keyboard, single click 
the selection box of each employee.  Each selected employee will be highlighted as selected. 

 To delete the selected records, press Delete key on the keyboard. 

A message “Are you sure you want to delete selected records?” will show up. Click Yes to delete selected records 
or click No to cancel deletion. 

 All rows that were highlighted will be deleted. 

 
How to Preview and Print Form 132 Report 

 To preview the report before printing it, select Print Preview Form 132 Report from the File menu or 
toolbar at the top of the screen. 

 This option is only available when a Form 132 is selected from the outline. 

 To print the report, select Print Form 132 Report from the File menu or from the toolbar. 
 This option is only available when a Form 132 is selected from the outline. 

 

How to Customize a Grid on the Form 132 
 
Font and background, column widths and row height could be modified in the grid on the Form 132. 
 

 To change a font in the grid, click Format Grid menu, then click Font.  In the Font dialog box, select 
desired font, font size and color, and click OK. 

 To change a background in the grid, click Format Grid menu, then click Background.  In the Color 
dialog box, specify the desired color and click OK. 
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 To adjust the column widths of the grid, move the pointer over a column divider in the column header 
area.  The pointer will become a horizontal double arrow.  Drag the divider left or right to adjust the width 
of the corresponding column. 

 To adjust the height of all grid rows, move the pointer over a divider in the record selector column.  
The pointer will become a vertical double arrow.  Drag the divider up or down to adjust the height.  All 
rows will be adjusted to the same height; you cannot have different heights for individual rows. 

 Custom layout for the grid on the Form 132 will be saved in the Layouts folder. 
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Schedule B Form 
The Schedule B Form includes three months listed in columns for the appropriate quarter.  Each of the 

three columns includes a line for each day of the month, and a monthly total field.  There is also a Total 
Liability field for the selected quarter in the bottom right corner of the form.  The information on this form 
may be modified any time the Schedule B form is displayed.  The File menu and toolbar provide options to 
Save and Print Schedule B.  Complete this form only if it is required (see the Oregon Combined Payroll Tax 
Report Instructions). 
 

 
 
For further information please see the following: 
• How to View the Schedule B Form Information 

• How to Add a New Schedule B Form 

• How to Edit the Schedule B Form Information 

• How to Delete a Schedule B Form 

• How to Preview and Print the Schedule B Form Report 

• How to Customize Grids on the Schedule B Form 

Importing Data: 
• Schedule B Importing 

• Multiple Business Schedule B Importing 
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Schedule B - State Withholding Tax 
Use this form if state income tax withholding deposits are required to be submitted semi-weekly or on 

a one-day banking basis.  File Oregon Schedule B with Form OQ.  
 
Schedule B Month 1 

Enter the Withholding Tax withheld from your employees during each payroll period.  Place these 
amounts in the cells that match the payroll dates for the first month of the quarter.  

 
Schedule B Month 2 

Enter the Withholding Tax withheld from your employees during each payroll period.  Place these 
amounts in the cells that match the payroll dates for the second month of the quarter.   

 
Schedule B Month 3 

Enter the Withholding Tax withheld from your employees during each payroll period.  Place these 
amounts in the cells that match the payroll dates for the third month of the quarter.  

 
Schedule B Month 1 Total 

Total liability for the first month of the quarter.  This value is calculated from the values entered in the 
Schedule B Month 1 column. 

 
Schedule B Month 2 Total 

Total liability for the first month of the quarter.  This value is calculated from the values entered in the 
Schedule B Month 2 column.  

 
Schedule B Month 3 Total 

Total liability for the first month of the quarter.  This value is calculated from the values entered in the 
Schedule B Month 3 column.  

 
Schedule B Total Liability 

Total liability for the quarter.  This value is calculated from the values calculated in Schedule B Month 
1, Schedule B Month 2, and Schedule B Month 3 totals. 

 
 

How to View the Schedule B Form Information 
 To view the Schedule B form information, select the Schedule B form listed under a selected quarter, 

from the outline list on the left panel. 
 
How to Add a New Schedule B Form 

 Add a new quarter to the outline. 
 A new quarter must be added in order to have a new Schedule B form.  See How to Add a New Quarter. 

 Select the Schedule B listed under the newly added quarter in the outline on the left panel. 

 Import data from another file into Schedule B. 

 For more information about importing data see Schedule B Importing. 

 If not importing, enter the dollar amounts in the appropriate columns. 
 For further information, please see the Oregon Combined Payroll Tax Report Instructions. 

 To save the new Schedule B form information, select Save from the File menu or from the toolbar. 
 The total for the Schedule B form automatically calculates and is copied to line 5B on Tax Info tab on Form OQ. 
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How to Edit the Schedule B Form Information 
 Select the Schedule B form to be modified from the left panel. 

 Modify the values in all appropriate fields. 

 To save changes, select Save from the File menu or from the toolbar. 
 The total for the Schedule B form automatically calculates and is copied to line 5B on Tax Info tab on Form OQ. 
 

How to Delete a Schedule B Form 
The selected quarter that the Schedule B form is listed under must be deleted in order to delete a Schedule B 

form.  See How to Delete Quarter Information. 
 

 

How to Preview and Print the Schedule B Form Report 
 To preview the report before printing it, select Print Preview Schedule B Report from the File menu or 

toolbar at the top of the screen. 
 This option is only available when a Schedule B form is selected from the outline. 

 To print the report, select Print Schedule B Report from the File menu or from the toolbar. 
 This option is only available when a Schedule B form is selected from the outline. 

 

How to Customize Grids on the Schedule B Form 
 
Font and background could be modified in the grids on the Schedule B Form. 

 
 To change a font in the 1st grid (2nd grid, 3rd grid), click Format Grid menu, then point to ‘Month1 

Grid’ (‘Month2 Grid’, ‘Month3 Grid’), then click Font.  In the Font dialog box, select desired font, font 
size and font color, then click OK.  

 To change a background in the in the 1st grid (2nd grid, 3rd grid), click Format Grid menu, then point 
to ‘Month1 Grid’, then click Background.  In the Color dialog box, specify the desired color and click 
OK. 

Custom layouts for the grids on the Schedule B Form will be saved in the Layouts folder. 
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Form OQ - Oregon Quarterly Tax Report 
This form is used to report the data on the Form OQ.  The form is separated into logical groupings on 

five tab windows. They include the Num. of Workers tab, the Tax Info tab, the Workers' Benefit Fund tab, 
the Monthly Withholding tab and the Special Payroll tab.  The Special Payroll tab appears only for a year 
and quarter when special payroll tax is due.  Also on the form, in the bottom right corner, is the calculated 
Total Payment Due field.  The data on this form may be modified any time the Form OQ screen is 
displayed.  The File menu and toolbar provide options to Save and Print Form OQ Report. 
 

Access portions of the form by clicking on the appropriate tab name.  If the name at the top of a tab has 
a rectangular square around it, arrow keys can be pressed to access those portions. 
 

 
 
For further information, please see the following: 
• How to View the Form OQ Information 

• How to Add a New Form OQ 

• How to Edit Form OQ Information 

• How to Delete a Form OQ 

• How to Preview and Print Form OQ Report 

• Number of Workers Tab 

• Tax Info Tab Field Descriptions  

• Workers' Benefit Fund  Field Descriptions  

• Monthly Withholding Tab Field Descriptions  

• Special Payroll Tab Field Descriptions  
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Importing Data: 
• Form OQ Importing 
• Multiple Business Form OQ Import 

 

Num. of Workers Tab 

 
Number of Workers Field Description 

 Enter the number of covered workers for state unemployment during the first, second, and third months 
of the quarter. 

 Each of the month fields must be filled in. 

 For further information, please see the Oregon Combined Payroll Tax Report Instructions. 

 
Number of Covered Workers 

These are the fields in which to enter the number of workers covered by unemployment insurance 
that were employed each month.  These fields default to zero (0) and must be filled in.   

The "monthly number of covered workers" you report on Form OQ should include all full-time and 
part-time workers who worked or received pay subject to unemployment insurance law during the payroll 
period which includes the 12th of the month. 

Some examples include: 
a. Daily pay period - enter the number of workers on the daily payroll for the workday nearest the 

12th of the month. 
b. Weekly, bi-weekly, or semi-monthly pay period - enter the number of workers on the payroll for the 

period which includes the 12th of the month. 
c. Monthly pay period - enter the number of workers on your monthly payroll. 
d. If there were no covered workers during any pay period, enter 0 (zero) in the appropriate boxes.  
Do not leave these boxes blank. 
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Tax Info Tab 
The tax info tab is where all of the different tax programs that are processed in the Oregon Combined 

Payroll Tax Report are entered and displayed.   

 
 Tax Info Tab Field Descriptions 

 Leave box 1A blank if employer was not subject to unemployment tax.   
 If employer was subject and there was payroll, box 1A is automatically filled from Form 132. 

 Enter a zero(0) in box 1A if employer was subject, but there was no payroll. 

 Press the Calculate Excess Wages button to fill In box 2A, or manually enter the amount of the 
"Excess Wages". 

 If there are wages from other states in addition to the Oregon wages, do not use the Calculate Excess Wages 
button.  In this instance, Excess Wages must be calculated manually.   Using the Calculate Excess Wages button 
will calculate only the wages from Oregon that have been entered in the OTTER System. 

 Employers reporting under the Local Government Employers Benefit Trust Fund option or the Reimbursing option 
enter 0 in box 2A and do not use the Calculate Excess Wages Button. 

 See the current Oregon Combined Payroll Tax Report instructions for definitions. 

 Box 3A is automatically filled in and cannot be modified. 

 In box 4A, Enter the employer's current tax rate.  Enter the rate as a decimal (if tax rate is 1.0%, enter 
.01). 

 Local Government Employers Benefit Trust Fund tax rates may vary during the year.  If you do not know the correct 
tax rate, call the nearest tax office.  The tax office phone numbers are listed on the Technical Support page.  
Employers reporting under the Reimbursing option, enter 0 for the tax rate.  Employers not subject to 
Unemployment Insurance reporting, leave box 4A blank. 

 Box 5A is automatically calculated and filled in.  It cannot be modified. 
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 In box 6A, enter the amount of tax already paid in the quarter for the employment tax program.  
 Do not include the amount being paid at the time of filing this report. 

 In box 1B, enter the total wages subject to State Withholding.  If employer was not subject to State 
Withholding, leave box 1B blank. 

 If depositing quarterly, enter the appropriate amount in box 5B. 

 If not depositing quarterly, the amount listed in box 5B transfers from either Schedule B or the total from 
the Monthly State Withholding tab on Form OQ. 

 In this case, Do not fill in box 5B. 

 In box 6B, enter the amount of tax already paid in the quarter for the withholding tax program.  
 Do not include the amount being paid at the time of filing this report. 

 Enter the appropriate amount in box 1C if employer is subject to TriMet.  If not subject to TriMet, leave 
box 1C blank. 

 Box 4C is automatically pre-filled and is not editable. 

 Box 5C is automatically calculated and filled.  It is not editable. 

 In box 6C, enter the amount of tax already paid in the quarter for TriMet tax.  
 Do not include the amount being paid at the time of filing this report. 
 

 Enter the appropriate amount in box 1D if employer is subject to Lane Transit District. If employer was 
not subject to Lane Transit District, leave box 1D blank 

 Box 4D is automatically pre-filled and is not editable. 

 Box 5D is automatically calculated and filled.  It is not editable. 

 In box 6D, enter the amount of tax already paid in the quarter for the Lane Transit District.  
 Do not include the amount being paid at the time of filing this report. 

 Line 8 is automatically calculated and is not editable. 

 The Total Payment Due field is automatically calculated and is not editable. 
 
 
Column A – Unemployment Insurance 
UI Subject Wages (Box 1A) 

This amount will reflect the total subject wages from Form 132.  If no subject wages were paid enter 
0 (zero) in this box.  If not subject to UI Tax, leave this box blank. 

 
Excess wages (Box 2A) 

Enter "Excess wages" in this box (use the Calculate Excess button if all previous quarters were 
entered and no out of state employees are involved).  Excess wages are wages above the taxable wage 
base for the year per person.  Reimbursing employers and Local Government Employers Benefit Trust 
Fund participants enter zero. 

 
Calculate Excess Button 

Use the calculate excess button to determine the excess wages.  This button should always be used 
unless:  

1.  All preceding quarters are not in the system (e.g. processing quarter 2 but quarter 1 is not 
entered) 

2.  Some employees have out of state wages 
3.  This business is a reimbursing employer. 
4.  This business is a Local Government Employee Benefit Trust Fund(LGEBTF) participant. 

 
Taxable Wages (Box 3A) 

This box is calculated by subtracting UI Excess Wages (Box 2A) from UI Subject Wages (Box 1A). 
 
UI Tax Rate (Box 4A) 

This box contains the current year's UI Tax rate for the selected business.  This value will prefill from 
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the default UI Tax Rate entered in the yearly form.  If you do not know your rate, call the Oregon 
Employment Department at 503-947-1488.  Reimbursing employers may leave this box blank or enter 0 
(zero). 

 
UI Tax (Box 5A) 

This box is computed by multiplying UI Taxable Wages (Box 3A) by UI Tax Rate (Box 4A) and rounding 
to the nearest cent. 

 
UI Prepaid (Box 6A) 

Enter the amount of UI Tax prepaid or credits used this quarter.  Include any credit amount that may 
have been overpaid in previous quarters.  Include any overpayments from previous quarters where no 
refund was requested or issued. 

UI tax payments are due one per quarter on the same day as the tax reports. 
 
UI Penalty and Interest Owed (Box 7A) 

Enter the amount of penalty and interest owed if the report is late.  Figure the penalty by multiplying 
the number of employees by $6.  The minimum penalty is $75.  The maximum penalty is $1,500.  If there 
were no employees, the penalty is $5.  Late reports are those submitted more than 10 days after the due 
date. 

To calculate interest owed, multiply the unpaid tax owed by 0.015 for each month or fraction of a 
month, after the date the payment is due.  Interest is assessed even if the payment is one day late. 

When calculating interest, use only the amount of unpaid tax.  Do not calculate interest on previously 
assessed interest or penalties. 

 
UI Total Due (Box 8A) 

This amount is computed by subtracting UI Tax prepaid (Box 6A) from UI Tax (Box 5A) and adding UI 
Penalty and Interest (Box 7A) (5A - 6A + 7A).  If the result is less than zero (overpaid), then zero (0) is 
entered. 

 
 

Column B – State Withholding 
SWT Subject Wages (Box 1B) 

Enter the total subject wages subject to income tax (salaries, commissions, and bonuses), paid to 
Oregon employees this quarter.  If you are reporting withholding on pension or annuity distributions, 
enter the amount of distributions with Oregon withholding.  This amount need not match box 1A.  Enter 0 
(zero) if you had no payroll this quarter. 

 
SWT Tax (Box 5B) 

If you deposit: 
Quarterly - Enter the total Oregon tax withheld this quarter. Enter zero (0) if you had no UI tax this 

quarter. 
Monthly - complete the monthly withholding information on the monthly withholding tab.  The total from 

the monthly withholding tab will automatically transfer to Box 5B. 
Semi-weekly or one-banking day depositors - Complete Oregon Schedule B.  The total from 

Schedule B will automatically transfer to Box 5B. 
 
SWT Prepaid (Box 6B) 

Enter the amount of withholding tax prepaid, including credits used, this quarter. 
 
SWT Total Due (Box 8B) 

This box is calculated by subtracting State Withholding Tax prepaid (Box 6B) from State Withholding 
Tax (Box 5B).  If the result is less than zero (overpaid), then 0 (zero) is entered. 

 

Column C – Tri-met District 
TriMet Subject Wages (Box 1C) 

Enter wages paid for work done in the Tri-Met district.  Enter 0 (zero) if there was no payroll in the 
district this quarter. Leave blank if not subject. 

 
TriMet Tax Rate (Box 4C) 

This rate is pre-filled from the System Tax Rate Table. 
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TriMet Tax (Box 5C) 

The box is calculated by multiplying Tri-Met Subject Wages (Box 1C) by Tri-Met Tax Rate (Box 4C) 
and rounding to the nearest cent. 

  
TriMet Prepaid (Box 6C) 

Enter the amount of Tri-Met tax prepaid, including credits used, this quarter. 
 
TriMet Total Due (Box 8C) 

This box is calculated by subtracting Tri-Met prepaid (Box 6C) from Tri-Met Tax (Box 5C).  If the 
result is less than zero (overpaid), then 0 (zero) is entered. 

 
Column D – Lane Transit District 
Lane Transit Subject Wages (Box 1D) 

Enter wages paid for work done in the Lane Transit district.  Enter 0 (zero) if there was no payroll in 
the district this quarter.  Leave blank if not subject. 

 
Lane Transit Tax Rate (Box 4D) 

This rate is pre-filled from the System Tax Rate Table. 
 
Lane Transit Tax (Box 5D) 

This box is calculated by multiplying Lane Transit Subject Wages (Box 1D) by Lane Transit Tax Rate 
(Box 4D) and rounding to the nearest cent. 

 
Lane Transit Prepaid (Box 6D) 

Enter the amount of Lane Transit District (LTD) tax prepaid, including credits used, this quarter. 
 
Lane Transit Total Due (Box 8D) 

This box is calculated by subtracting Lane Transit Prepaid (Box 6D) from Lane Transit Tax Box 5D.  
If the result is less than zero (overpaid), then 0 (zero) is entered.  

 
 

Total Payment Due 
 This box is calculated by adding Total UI Tax Due (Box 8A), Total State Withholding Tax Due (Box 8B), 

Total Tri-Met Tax Due (Box 8C), Total Lane Transit Tax Due (Box 8D), and Total WBF Assessment Due (Box 
13).  This does not include any credits. Credits cannot be transferred between programs using the Form 
OQ.  (See Credit Handling). 
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Workers' Benefit Fund Tab 
The Workers' Benefit Fund Tab is where the information pertaining to the Workers' Benefit Fund is 

captured and displayed.  This assessment is in addition to the Workers' Compensation insurance premium. 
 

 
Workers' Benefit Fund Tab Field Descriptions 

 In line 9, enter the number of hours subject to the Workers' Benefit Fund (WBF) Assessment. 

 Enter whole numbers only.  This number does not have to equal the number of hours found on Form 132 since the 
two programs have different subjectivity requirements. 

 Line 10 contains the WBF Assessment rate.  It is not editable. 

 Line 11 contains the Total Assessment and is automatically calculated.  It is not editable. 

 In line 12, enter the amount of WBF assessment already paid for this quarter.   

 Do not include the amount being paid at the time of filing this report. 

 The program calculates the amount in line 13 as line 11 minus line 12.  If line 11 is smaller than line 
12, the program enters "0" in accordance with the instructions in the current Oregon Combined Payroll 
Tax Report booklet. 

 
WBF Hours Worked (Box 9) 

Enter sum of all hours worked by all workers, except volunteers, who are subject to Workers' Benefit 
Fund assessment.  Round the sum of hours to the nearest whole.  If you do not track actual hours 
worked, you may use a flat rate of 40 hours per week or 174 hours per month (prorate for part-time 
workers).  If you have other information showing hours worked (such as a contract), you may use this 
information to determine hours worked.  Include overtime hours.  Do not include standby time.  (You 
must document how calculations are made in case of an audit.)  If you have no hours or only volunteer 
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workers' hours to report for the quarter, enter 0 (zero). 
 
WBF Assessment Rate (Box 10) 

This rate is pre-filled from the System Tax Rate Table. 
 
WBF Total Assessment (Box 11) 

This box is calculated by multiplying WBF hours worked (Box 9) by WBF assessment rate (Box 10) 
and rounding to the nearest cent. 

 
WBF Prepaid (Box 12) 

Enter the amount of prepaid WBF assessment, or WBF assessment credits used, this quarter. 
 
WBF Total Due (Box 13) 

This box is calculated by subtracting WBF assessment prepaid (Box 12) from WBF total assessment 
(Box 11).  If the result is less than zero (overpaid), then 0 (zero) is entered. 
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Monthly State Withholding Tab 
 

Monthly Withholding (Line 15) 
This line is for those who are required to deposit on a monthly basis.  Show the amount 

withheld in each month of the quarter.  The total is the sum of the three months. 
Do not include payments made for unemployment insurance tax, Workers' Benefit 

Fund assessment, or transit taxes in these boxes. 
If you deposit only once a quarter, enter the total amount withheld in State Withholding Tax 

(Box 5B) only. 
If you must deposit withholding on a daily or semi-weekly basis, do not complete this line.  

Report withholding on Oregon Schedule B.  (For determining how often withholding must be 
deposited, see Guidelines for withholding due dates). 

 

 
Monthly Withholding Tab Field Descriptions 

 Skip the Withholding Only line if: 

• You are not subject to State Withholding. 

• You are subject to State Withholding but use Schedule B to report amounts withheld. 

• You are subject to State Withholding but deposit quarterly. 

• You are subject to State Withholding but had no subject payroll this quarter. 

• Your State Withholding is reported on the annual Form WA. 

 If State Withholding tax is deposited on a monthly basis, enter the amounts withheld from your 
employees during each month of the quarter. 

 The Total field is automatically calculated and cannot be edited. 
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 The Total Payment Due field is automatically calculated and cannot be edited. 
 
 
Withholding Month 1 (Item 15 box 1) 

Used only if required to deposit on a monthly basis.  Show the amount withheld for the first month of 
the quarter. 

 
Withholding Month 2 (Item 15 box 2) 

Used only if required to deposit on a monthly basis.  Show the amount withheld for the second 
month of the quarter. 

 
Withholding Month 3 (Item 15 box 3) 

Used only if required to deposit on a monthly basis.  Show the amount withheld for the third month 
of the quarter. 

 
Withholding Total 

This is the total withholding for the selected quarter.  This box is calculated by adding Withholding 
Month 1, Withholding Month 2, and Withholding Month 3. 
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Special Payroll Tab 
The Special Payroll tab is visible in odd number years through 2006. Starting in 2007 it is visible in 

every quarter.  The Special Payroll Tax transfers a small percentage of the total taxable wages to funds 
such as the Wage Security Fund. All such transfers were mandated by the Oregon legislature.  The 
special payroll tax is computed by multiplying the special payroll tax rate by UI Taxable Wages (Box 3A). 

 

 
Special Payroll Tab Field Descriptions 

 The Special Payroll tab will appear only on a Form OQ if the Form OQ is listed under a year and 
quarter when special payroll tax is due. 

 Line 16 and Line 17 are both automatically calculated and filled in.  These fields cannot be edited. 
 
 
 
Special Payroll Tax (Box 16) 

The special payroll tax is computed by multiplying UI Taxable Wage (Box 3A) by the special payroll tax 
rate.  

 
UI Trust Fund (Box 17) 

This box is calculated by subtracting the Special Payroll Tax (Box 16) from the UI Taxable Wages (Box 
3A).  This amount is applied to the UI Trust Fund.  Use this amount on federal Form 940 or 940EZ as the 
tax actually paid to the state for the particular quarter.  Do not add or subtract this figure from taxes 
owed. 
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How to View the Form OQ Information 

 To view Form OQ information, select the Form OQ line under a selected quarter from the outline on the 
left panel. 

 Click on the appropriate tab on the top of the tab window, or use the arrow keys to access the correct 
tab. 

 
How to Add a New Form OQ 

 Add a new quarter to the outline. 

 A new quarter must be added to create a new Form OQ.  See How To Add A New Quarter. 

 Select the Form OQ listed under the newly added quarter in the outline on the left panel. 

 Click on the individual tabs and enter information into the appropriate fields. 

Please see Num. of Workers Tab field descriptions for further information. 

Please see Tax Info Tab field descriptions for further information about the Tax Info. 

Please see Workers' Benefit Fund Tab field descriptions for further information about the Workers' Benefit Fund 
info. 

Please see Monthly Withholding Tab field descriptions for further information about the Monthly State 
Withholding. 

Please see Special Payroll Tab field descriptions for further information about the Special Payroll tab. 

 To save the new Form OQ information, select Save from the File menu or from the toolbar. 
 
 
How to Edit Form OQ Information 

 Select the Form OQ to be modified from the outline on the left panel. 

 Modify the values in all appropriate fields. 

 To save changes, select Save from the File menu or from the toolbar. 
 
 
How to Delete a Form OQ 

The selected quarter that the Form OQ is listed under must be deleted in order to delete a Form OQ.  See How To 
Delete Quarter Information. 
 
 
How to Preview and Print Form OQ Report 

 To preview the report before printing it, select Print Preview Form OQ Report from the File menu or 
toolbar at the top of the screen. 

 This option is only available when a Form OQ is selected from the outline on the left panel. 

 To print the report, select Print Form OQ Report from the File menu or from the toolbar. 

 This option is only available when a Form OQ is selected from the outline on the left panel. 
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How to Make a Transfer File 

Quarterly reports must be validated before making the transfer file.  

 From the Validate Quarter screen, click on Make Transfer File or select Make Transfer File from the 
File menu on the menu bar. 

 The Year and Quarter Selection screen in the Make Transfer File Wizard will appear. 

 
 Select the year and quarter(s) to be transferred. 

 Only current and past quarters may be reported.  Therefore only current and past quarters are listed. 

 Select Cancel to exit the Make Transfer File Wizard. 

 Select Next to continue through the Make Transfer File Wizard. 

 The Report Selection Screen in the Make Transfer File Wizard will appear. 
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 Select all the reports to include in the transfer file.  

 Only Validated reports may be selected.  Reports that have not been validated are colored red.  The number of 
validated and non-validated reports is shown on the right side of the screen. 

 To validate reports shown in red, select the report lines that need to be validated (one at a time) and 
press the Validate button. 

 Select Cancel to exit the Make Transfer File Wizard. 

 Select Back to return to the previous Make Transfer File Wizard screen. 

 Select Next to continue through the Make Transfer File Wizard. 

 The File Selection screen in the Make Transfer File Wizard will appear. 
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 Select the drive and folder in which to save the transfer file. 

 The default drive and folder is the path of your OTTER32.exe (e.g. c:\Program Files\Otter32).  The transfer file will 
be saved as OTTERTRF.ZIP. 

 If you are reporting by diskette, insert a blank disk into the floppy drive and use the down arrow in the 
Drives field to select the correct drive letter. 

 Select Next to save the file out to the selected folder. 

 Select Back to return to the previous Make Transfer File Wizard screen. 

 Select Cancel to exit the Make Transfer File Wizard. 

 The results screen will report the number of businesses transferred, the names of the reports, and 
whether the transfer was successful. 
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 Select Send Report to bring up the Secure Wage Report Upload site. 

 It will also give information on how to transfer the file using the secure server or prepare the diskette to 
transmit to the Employment Department. 

 You can transfer the file using the Secure Wage Report Upload site 
http://findit.emp.state.or.us/tax/secure-upload/, or via email by composing an email message and 
attaching the Ottertrf.zip file that was created through this process. 

http://findit.emp.state.or.us/tax/secure-upload/
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 Select OTTER Report then click on Continue.  

 

 File out information then click on Send.  
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Sending Reports and Payments 

Send Payments 
Mail PAYMENT due along with an Oregon Combined Tax Payment Coupon (OTC) to: 
 
 Oregon Department of Revenue 
 PO Box 14800 
 Salem OR   97309-0920 
 
PLEASE DO NOT SEND DISKETTES TO THE OREGON DEPARTMENT OF REVENUE. 
 
 
Transferring report data: 
 
 See How to Make a Transfer File to create the file to transfer to the Oregon Employment Department 
 
 By Secure Server: See Transfer File using the Secure Server. 
  
 By Diskette:  See Send Reports on Diskette. 
  
 By E-Mail: See Transfer File by E-Mail. 
 
 
Transfer file by Secure Server 
See How to Make a Transfer File (OTTERTRF.ZIP) to submit to the Oregon Employment Department. 
 

1. Log onto the internet. 

2. Go to http://findit.emp.state.or.us/tax/secure-upload (you may click on this link) 

3. On the opened web page — Select Report Type -- click inside the radio button beside OTTER 
Report, then click the continue button.  This web page will already be opened for you if you went 
through the steps of making a transfer file and clicked on the send report button. 

4. Fill in the required information. If you are sending multiple reports, list a single business name and 
BIN from your zip file. We will send a response to the email address you insert. Select the correct 
quarter and year. Use the browse button to find your OTTERTRF.ZIP file from your computer (it 
defaults to C:\Program Files\OTTER32 subdirectory). Double click on the file to place its address in 
the attach file box. 

5. Click the Send button and your file will be directed to our secure server. 
 

Transfer File by E-mail 
See How to Make a Transfer File to create the file (OTTERTRF.ZIP) to submit to the Oregon Employment 
Department 

 

 Not all e-mail software packages can add an attachment to an e-mail message.  The most common 
forms permit attachments.  Some e-mail only software may not have attachment options.  Look through 
documentation that came with your e-mail software to determine if it has attachment capabilities. 

1. Using your e-mail software, create a new message to be sent, using the following address:    

 OTTER@emp.state.or.us 
2. In the Subject line of the e-mail put the Business Identification Number of the business.  If multiple 

businesses are being reported, please list the first business in the Subject line.  In the body of the 
message put the number of accounts included in the OTTERTRF.ZIP file. 

3. Attach the OTTERTRF.ZIP file to the e-mail message.  Look for the file in the OTTER32 directory.  For 
information on how to attach a file to an e-mail message, please refer to the documentation that came 

http://findit.emp.state.or.us/tax/secure-upload
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with your e-mail software. 

4. If the sent message was unsuccessful, a return message will be sent saying there was a problem. 
Check the address.  It should say: OTTER@emp.state.or.us.  Try to send the file again by attaching 
OTTERTRF.ZIP to a new e-mail message. If unsuccessful, use Transfer file by Secure Server. 

5. When sending report via E-mail or using the Secure Wage Report Unload, you will receive a receipt 
verification e-mail within 24-48 hours. 

 

 

Send Reports on Diskette 
See How to Make a Transfer File to create the file (OTTERTRF.ZIP) to submit to the Oregon Employment 
Department 

 
1. Write the quarter and year of the reports, the preparer's name, the preparer's phone number, and the 

number of reports on the diskette label. 
  

2. Please use a diskette mailer to help safeguard the diskette from damage. 
  
3. Mail the DISKETTE to: 

 
Oregon Employment Department 
Tax Section - OTTER 
875 Union St. NE 
Salem OR 97311-0030 
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 Options 
For further information, please see the following: 
• How to Change Colors  

• How to Change the Default Preparer Information 

 
 
How to Change Colors 

 Select Options from the File menu on the top menu bar. 

 The Options dialog box will appear. 

 
 Select the General tab. 

 Select the Text button to change the color of the text in all required data fields. 

 Select the Background button to change the background in all required data fields. 

 Select a color. 

 Select the OK button to save the color change. 

 Select the Cancel button to cancel the color change. 
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How to Change the Default Preparer Information 
Changing the default preparer information will not change existing data.  It will change the default preparer 
information for new quarters. 

 Select Options from the File menu on the menu bar. 

 The Options dialog box will appear. 

 
 Select the Preparer tab. 

 Modify fields as needed. 

 Select the OK button to save the preparer information change. 

 Select the Cancel button to cancel the preparer information change. 

 Note: Required fields have a background of different color. 
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Utilities 
For further information, please see the following: 
• Importing Form 132 Data 

• Importing Schedule B Data 

• Importing Form OQ Data 

• Multiple Business Form 132 Import  

• Multiple Business Schedule B Import  

• Multiple Business Form OQ Import  

• How to Export Data from a Form 132  
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Form 132 Importing 

 Select Utilities from the File menu on the menu bar. 

 Select Import Form 132 Data from Utilities. 

 The Import Form 132 Data dialog box will appear.  This menu item is only available when a Form 132 is selected 
from the outline on the left panel of the screen. 

 

 Select the type of file to import from the Data Format list. 

 Depending upon what data format is selected; different options will appear at the bottom of the Import Form 132 
Data dialog box.  For further information, see Data Format Types below.   

 Note:  If this is the first time import has been used, the default data format is Delimited Text (ASCII).  If the import 
has been used previously, the default data format will be the data format of the last successful import. 

 Type in the full path of the file name or select the Browse button on the right side of the dialog box to 
find the correct file to import. 

 The line of text below the File Name is an example of how the file should look.  If this is not how the file 
to be imported is formatted, the options in the bottom half of the screen will need to be used to adjust 
the import format. 

 Select OK to start the import of the Form 132 data. 

 To preview results of the importing, click the Preview Results button. 

 Note: the most recent successful import profile will be saved and retrieved the next time import is 
selected. 

 
 To Import more than one business's Form 132 information in one process, please see Multiple Business 
Form 132 Import. 
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Data Format Types 
 
Import Data Formats for Single Business importing 
 
Delimited Text (ASCII) 

Fixed Width Text(ASCII) 

Microsoft Excel 3.0, 4.0, 97 

Microsoft Access 2.0, Access 97 

Lotus wks, wk1, wk3, wk4 

MMREF-1 (512 Byte) 

Paradox 3.x, 4.x, 5.x 

Dbase III, IV 

FoxPro 2.0, 2.5, 2.6, 3.0 
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ASCII Delimited Text 

 Enter the name of the file to import or press the Browse button and select the desired file. 

 If the filename ends with ".txt", the first 3 lines of the file (preview) should be displayed in the list in the 
middle of the form. 

 

 
 
 Choose the order of how the fields will be imported. 
 Using the mouse, click on the heading of the different fields and drag them to the correct position for 

importing the text file. 
 The order of the SSN, Last Name, First Name, Middle Initial, Hours, and Wages Paid should match the order in 

which they appear in the delimited text file (See the preview list). 

 To exclude non-required fields from being imported, remove the checkmark in the box below the field 
name by placing the cursor in the desired column and clicking or by hitting the Delete key on the 
keyboard.  To reselect the fields, click in the check box again, or hit the Insert key on the key board. 

 Only the non-required fields (Middle Initial, Hours and Wages) may be excluded. 

 The Field Separator is the character that divides the fields in the text file.  The default field separator is 
the comma. 

 The Field Delimiter is the character that encloses the fields in the text file.  The default field delimiter is 
the double quote.  The field delimiter can be left blank which means there is no delimiter in the file. 

 The Delimiters on Numbers check box indicates that the numeric fields (hours and wages) are also 
enclosed by the Field Delimiter.  The default is not checked, which means the numbers do not have 
delimiters.  

 The Implicit Decimal in Wages check box indicates that no decimal point is present in the wages and 
the program is to assume two decimal places.  This allows the wages to be stored without decimal point.  
The default is unchecked, which indicates that the decimal point is present in the file. 
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Fixed Width Text (ASCII) 

 Enter the name of the file to import or press the Browse button and select the desired file.  

 Choose the order of how the fields will be imported and the lengths of each field. 
 

 
 
 The size and position options will appear in the grid at the bottom of the Import Form 132 Data dialog box.  The 

field lengths for Fixed Width Text (ASCII) appear under the field names. 

 Using the mouse, click on the heading of the different columns and drag them to the correct position for 
importing the text file. 

 The order of the SSN, Last Name, First Name, Middle Initial, Hours, and Wages Paid should match the order in 
which they appear in the fixed width text file (See preview list). 

 In the box below each field name, type in the length of the field in the ASCII text file. 

 To exclude non-required fields from being imported, click on the column heading of the field and press 
the Delete key on the keyboard.  The color of the column heading will change color and the field will not 
be included in the example text line below the File Name field on the screen.  To reselect a field press 
the Insert key on the key board while the appropriate column is selected. 

 Only the non-required fields (Middle Initial, Hours or Wages) may be excluded. 

 The Implicit Decimal in Wages check box indicates that no decimal point is present in the wages and 
the program is to assume two decimal places.  This allows the wages to be stored without decimal 
point.  The default is unchecked, which indicates that the decimal point is present in the file. 
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Microsoft Access 2.0, 97 

 Enter the name of the file to import or press the Browse button and select the desired file.  

 Select the table name to be imported from the "Tables" drop list. 
 

 
  

A list of field names found in the selected table will appear on the bottom of the Import Form 132 Data dialog box 
under the heading Import Field. 
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 For each field listed on the left that will be imported, place the cursor in the corresponding field on the 

right. 
 A down arrow will appear on the far right of the field that the cursor is focused on. 

 Place the cursor on the arrow and select the Form 132 field into which the corresponding field on left will 
be imported. 

 When all matches are made press the OK button. 

 A confirmation of completion should be received.  If not, correct specified errors and try again. 
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Use for: 
Microsoft Excel 3.0, 4.0, 97, 2000, 2002, 2003 
Lotus wks, wk1, wk3, wk4 

 Enter the name of the file to import or press the Browse button and select the desired file.  

 Select the worksheet name to be imported from the "Worksheets" drop list. 

 

 A list of field names (Column Headings - 1st row of worksheet) found in the selected file will appear on 
the bottom of the Import Form 132 Data dialog box under the heading Import Field.   

 For each field listed on the left that will be imported, place the cursor in the corresponding field on the 
right. 

 A down arrow will appear on the far right of the field that the cursor is focused on. 

 Place the cursor on the arrow and select the Form 132 field into which the corresponding field on left will 
be imported. 
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 Press the OK button.  A completion verification should be displayed.  If an error message is received, 
correct indicated error and try again. 
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Federal Diskette (128 Byte) 

 
  
These records should have a uniform 128-character length.  There are four record types: 1E and 2E contain 
employer information, 1S and 2S contain Employee information (Supplemental). 
 
 See Federal 128 Byte Record Layouts for specific information on how to format the records. 
 
 

Federal Diskette (275 Byte) 

 

 
  
These records should have a uniform 275-character length.  There are two record types: E contains 
employer information, S contains Employee information (Supplemental). 
 
 See Federal 275 Byte Record Layouts for specific information on how to format the records. 
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MMREF-1 (512 Byte) 

 Enter the name of the file to import or press the Browse button and select the desired file.  

 
  
These records should have a uniform 512-character length.  There are two record types: RE contains 
employer information, RS contains Employee information (State). 
 
 See MMREF-1 512 Byte Record Layouts for specific information on how to format the records. 
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Paradox 3.x, 4.x, 5.x 
Dbase III, IV 
FoxPro 2.0, 2.5, 2.6, 3.0 
 

 

 Enter the name of the file to import or press the Browse button and select the desired file.  
 A list of field names found in the selected file will appear on the bottom of the Import Form 132 Data 

dialog box under the heading Import Field.   

 For each field listed on the left that will be imported, place the cursor in the corresponding field on the 
right. 

 A down arrow will appear on the far right of the field that the cursor is focused on. 

 Place the cursor on the arrow and select the Form 132 field into which the corresponding field on left will 
be imported. 

 A confirmation of completion should be received.  If not, correct specified errors and try again. 
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Schedule B Importing 
 Select the Schedule B of the Business and Year/Quarter into which you wish to import data. 

 Select Utilities from the File menu on the menu bar. 

 Select Import Schedule B Data from Utilities. 

 The Import Schedule B Data dialog box will appear.  This menu item is only available when a Schedule B is 
selected from the outline on the left panel of the screen. 

 

 Select the type of file to import from the Data Format list. 

 Depending upon what data format is selected; different options will appear at the bottom of the Import Schedule B 
Data dialog box.  For further information, see Schedule B Data Formats. 

 Note:  If this is the first time import has been used, the default data format is Delimited Text (ASCII).  If the import 
has been used previously, the default data format will be the data format of the last successful import. 

 Type in the full path of the file name or select the Browse button on the right side of the dialog box to 
find the correct file to import.` 

 The line of text below the File Name is an example of how the file should look.  If this is not how the file 
to be imported is formatted, the options in the bottom half of the screen will need to be used to adjust 
the import format. 

 Select OK to start the import of the Schedule B data. 

 

 Note: the most recent successful import profile will be saved and retrieved the next time import is 
selected. 

 Note: If errors in the data format/content are determined, no data from the selected file will be imported.  
A maximum of ten (10) errors will be reported before data validation is aborted.  



 73

Import Data Formats for Single Schedule B importing 

Delimited Text (ASCII) 
Fixed Width Text (ASCII) 
Microsoft Access 2.0, Access 97 
Microsoft Excel 3.0, 4.0, 97 
Lotus wks, wk1, wk3, wk4 
Paradox 3.x, 4.x, 5.x 
Dbase III, IV 
FoxPro 2.0, 2.5, 2.6, 3.0
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Delimited Text (ASCII) 

 Enter the name of the file to import or press the Browse button and select the desired file.  

 
 

 If the filename ends with ".txt", the first 3 lines of the file (preview) should be displayed in the list in the 
middle of the form. 
 Choose the order of how the fields will be imported. 

 Using the mouse, click on the heading of the different fields and drag them to the correct position for 
importing the text file. 

 The order of the Date and Amount should match the order in which they appear in the delimited text file (See the 
preview list). 

 To exclude non-required fields from being imported, remove the checkmark in the box below the field 
name by placing the cursor in the desired column and clicking or by pressing the Delete key on the 
keyboard.  To reselect the fields, click in the check box again, or press the Insert key on the keyboard. 

 Only the non-required fields may be excluded. 

 The Field Separator is the character that divides the fields in the text file.  The default field separator is 
the comma. 

 The Field Delimiter is the character that encloses the fields in the text file.  The default field delimiter is 
the double quote.  The field delimiter can be left blank which means there is no delimiter in the file. 

 The Delimiters on Numbers check box indicates that the numeric fields (Amount) are also enclosed by 
the Field Delimiter.  The default is not checked, which means the numbers do not have delimiters.  

 The Implicit Decimal in Amount check box indicates that no decimal point is present in the Amount 
and the program is to assume two decimal places.  This allows the Amount to be stored without decimal 
point.  The default is unchecked, which indicates that the decimal point is present in the file.  

 
 When all options are set, click the OK button. 

 A confirmation of completion should be received.  If not, correct specified errors and try again. 

 



 75

Fixed Width Text (ASCII) 

 Enter the name of the file to import or press the Browse button and select the desired file. 

 If the filename ends with ".txt", the first 3 lines of the file (preview) should be displayed in the list in the 
middle of the form. 

 

 
 

 Choose the order of how the fields will be imported and the lengths of each field. 

 The size and position options will appear in the grid at the bottom of the Import Schedule B Data dialog box.  
The field lengths for Fixed Width Text (ASCII) appear under the field names. 

 Using the mouse, click on the heading of the different columns and drag them to the correct position for 
importing the text file. 

 The order of the Date and Amount should match the order in which they appear in the fixed width text file (See 
preview list). 

 In the box below each field name, type in the length of the field in the ASCII text file. 

 To exclude non-required fields from being imported, click on the column heading of the field and press 
the Delete key on the keyboard.  The color of the column heading will change and the field will not be 
included in the example text line below the File Name field on the screen.  To reselect a field press the 
Insert key on the keyboard while the appropriate column is selected. 

 Only the non-required fields may be excluded. 

 The Implicit Decimal in Amount check box indicates that no decimal point is present in the Amount 
and the program is to assume two decimal places.  This allows the Amount to be stored without decimal 
point.  The default is unchecked, which indicates that the decimal point is present in the file.  

 
 When all options are set, click the OK button. 

 A confirmation of completion should be received.  If not, correct specified errors and try again. 
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Microsoft Access 2.0, 97 

 Enter the name of the file to import or press the Browse button and select the desired file.  

 Select the table name to be imported from the "Tables" drop list. 
 

 
  

 A list of field names found in the selected table will appear on the bottom of the Import Schedule B Data dialog 
box under the heading Import Field. 

 For each field listed on the left that will be imported, place the cursor in the corresponding field on the 
right. 

 A down arrow will appear on the far right of the field that the cursor is focused on. 

 Place the cursor on the arrow and select the Schedule B field into which the corresponding field on the 
left will be imported. 
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 When all matches are made press the OK button. 

 A confirmation of completion should be received.  If not, correct specified errors and try again. 
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Microsoft Excel 3.0, 4.0, 97 

Lotus wks, wk1, wk3, wk4 

 Enter the name of the file to import or press the Browse button and select the desired file.  

 Select the worksheet name to be imported from the "Worksheets" drop list. 
 

 
 A list of field names (Column Headings - 1st row of worksheet) found in the selected file will appear on 

the bottom of the Import Schedule B Data dialog box under the heading Import Field.   

 For each field listed on the left that will be imported, place the cursor in the corresponding field on the 
right. 

 A down arrow will appear on the far right of the field that the cursor is focused on. 

 Place the cursor on the arrow and select the Schedule B field into which the corresponding field on left 
will be imported. 
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 Press the OK button. 

 A completion verification should be displayed. If an error message is received, correct indicated error 
and try again. 
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Paradox 3.x, 4.x, 5.x 

dBase III, IV 

FoxPro 2.0, 2.5, 2.6, 3.0 

 
 Enter the name of the file to import or press the Browse button and select the desired file.  

  
 A list of field names found in the selected file will appear on the bottom of the Import Schedule B Data 

dialog box under the heading Import Field.   

 For each field listed on the left that will be imported, place the cursor in the corresponding field on the 
right. 

 A down arrow will appear on the far right of the field that the cursor is focused on. 

 Place the cursor on the arrow and select the Schedule B field into which the corresponding field on left 
will be imported. 
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 Press the OK button 

 A completion verification should be displayed.  If an error message is received, correct indicated error 
and try again. 
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Form OQ Importing 
 
 Select the Form OQ of the Business and Year/Quarter into which you wish to import data. 

 Select Utilities from the File menu on the menu bar. 

 Select Import Form OQ Data from Utilities. 

 
 The Import Form OQ Data dialog box will appear.  This menu item is only available when a Form OQ is selected 

from the outline on the left panel of the screen. 

 Select the type of file to import from the Data Format list. 

 Depending upon what data format is selected, different options will appear at the bottom of the Import Form OQ 
Data dialog box.  For further information, see Form OQ Data Formats. 

 Note:  If this is the first time import has been used, the default data format is Delimited Text (ASCII).  If the import 
has been used previously, the default data format will be the data format of the last successful import. 

 Type in the full path of the file name or select the Browse button on the right side of the dialog box to 
find the correct file to import. 

 Select OK to start the import of the Form OQ data. 

 Note: the most recent successful import profile will be saved and retrieved the next time import is 
selected. 

 Note: If errors in the data format/content are determined, no data from the selected file will be imported.  
A maximum of ten (10) errors will be reported before data validation is aborted.  

 
 To Import more than one business's Form OQ information in one process, please see Multiple Business 

Form OQ Import. 
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Import Data Formats for Single Form OQ Importing 
 
Delimited Text (ASCII) 
Fixed Width Text (ASCII) 
Microsoft Access 2.0, Access 97 
Microsoft Excel 3.0, 4.0, 97 
Lotus wks, wk1, wk3, wk4 
Paradox 3.x, 4.x, 5.x 
Dbase III, IV 
FoxPro 2.0, 2.5, 2.6, 3.0 
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Delimited Text (ASCII) 

 Enter the name of the file to import or press the Browse button and select the desired file.  

 
 

 If the filename ends with ".txt", the first 3 lines of the file (preview) should be displayed in the list in the 
middle of the form.  
 Choose the order of how the fields will be imported. 

 Using the mouse, click on the heading of the different fields and drag them to the correct position for 
importing the text file. 

 The order of the fields should match the order in which they appear in the delimited text file (See the preview list). 

 To exclude non-required fields from being imported, remove the checkmark in the box below the field 
name by placing the cursor in the desired column and clicking or by pressing the Delete key on the 
keyboard.  To reselect the fields, click in the check box again, or press the Insert key on the keyboard. 

 Only the non-required fields may be excluded. 

 The Field Separator is the character that divides the fields in the text file.  The default field separator is 
the comma. 

 The Field Delimiter is the character that encloses the fields in the text file.  The default field delimiter is 
the double quote.  The field delimiter can be left blank which means there is no delimiter in the file. 

 The Delimiters on Numbers check box indicates that the numeric fields are also enclosed by the Field 
Delimiter.  The default is not checked, which means the numbers do not have delimiters.  

 The Implicit Decimal in Amounts check box indicates that no decimal point is present in the dollar 
amount fields and the program is to assume two decimal places.  This allows the dollar amounts to be 
stored without decimal point.  The default is unchecked, which indicates that the decimal point is present 
in the file. 

 When all options are set, click the OK button. 

 A confirmation of completion should be received.  If not, correct specified errors and try again. 
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Fixed Width Text (ASCII) 

 Enter the name of the file to import or press the Browse button and select the desired file.  

 
 

 If the filename ends with ".txt", the first 3 lines of the file (preview) should be displayed in the list in the 
middle of the form.  

 Choose the order of how the fields will be imported and the lengths of each field. 

 The size and position options will appear in the grid at the bottom of the Import Form OQ Data dialog box.  The 
field lengths for Fixed Width Text (ASCII) appear under the field names. 

 Using the mouse, click on the heading of the different columns and drag them to the correct position for 
importing the text file. 

 The order of the fields should match the order in which they appear in the fixed width text file (See preview list). 

 In the box below each field name, type in the length of the field in the ASCII text file. 

 To exclude non-required fields from being imported, click on the column heading of the field and press 
the Delete key on the keyboard.  The color of the column heading will change.  To reselect a field press 
the Insert key on the keyboard while the appropriate column is selected. 

 Only the non-required fields may be excluded. 

 The Implicit Decimal in Amounts check box indicates that no decimal point is present in the dollar 
amount fields and the program is to assume two decimal places.  This allows the dollar amount fields to 
be stored without decimal point.  The default is unchecked, which indicates that the decimal point is 
present in the file. 

 
 When all options are set, click the OK button. 

 A confirmation of completion should be received.  If not, correct specified errors and try again. 



 86

Microsoft Access 2.0, 97 

 Enter the name of the file to import or press the Browse button and select the desired file.  

 Select the table name to be imported from the "Tables" drop list. 
  

 

 A list of field names found in the selected table will appear on the bottom of the Import Form OQ Data dialog 
box under the heading Import Field. 

 For each field listed on the left that will be imported, place the cursor in the corresponding field on the 
right. 

 A down arrow will appear on the far right of the field that the cursor is focused on. 

 Place the cursor on the arrow and select the Form OQ field into which the corresponding field on left will 
be imported. 
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 When all matches are made press the OK button. 

 A confirmation of completion should be received.  If not, correct specified errors and try again. 
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Microsoft Excel 3.0, 4.0, 97 

Lotus wks, wk1, wk3, wk4 

 Enter the name of the file to import or press the Browse button and select the desired file.  

 Select the worksheet name to be imported from the "Worksheets" drop list. 
 

 
 A list of field names (Column Headings - 1st row of worksheet) found in the selected file will appear on 

the bottom of the Import Form OQ Data dialog box under the heading Import Field. 

 For each field listed on the left that will be imported, place the cursor in the corresponding field on the 
right. 

 A down arrow will appear on the far right of the field that the cursor is focused on. 

 Place the cursor on the arrow and select the Form OQ field into which the corresponding field on left will 
be imported. 
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 Press the OK button. 

 A completion verification should be displayed.  If an error message is received, correct indicated error 
and try again. 
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Paradox 3.x, 4.x, 5.x 

dBase III, IV 

FoxPro 2.0, 2.5, 2.6, 3.0 

 
 Enter the name of the file to import or press the Browse button and select the desired file.  

  
 A list of field names found in the selected file will appear on the bottom of the Import Form OQ Data 

dialog box under the heading Import Field.   

 For each field listed on the left that will be imported, place the cursor in the corresponding field on the 
right. 

 A down arrow will appear on the far right of the field that the cursor is focused on. 

 Place the cursor on the arrow and select the Form OQ field into which the corresponding field on left will 
be imported. 
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 Press the OK button. 

 A completion verification should be displayed.  If an error message is received, correct indicated error 
and try again. 
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Multiple Business Form 132 Import: 

 Select Utilities from the File menu on the menu bar. 

 Select Multiple Business Form Imports from the Utilities menu.  This menu item is available when not in 
edit mode. 

 Select Multiple Business Form 132 Import. 

 The Multiple Business Form 132 Data Import dialog box will appear.    

 

 Select the type of file to import from the Data Format list. 

 Depending upon what data format is selected, different options will appear at the bottom of the Multiple 
Business Form 132 Data Import dialog box.  For further information, see Multi Form 132 Data Formats below. 

 Note:  If this is the first time import has been used, the default data format is Delimited Text (ASCII).  If the import 
has been used previously, the default data format will be the data format of the last successful import. 

 Type in the full path of the file name or select the Browse button on the right side of the dialog box to 
find the correct file to import.   

 Note: Multiple files may be selected for import from the Browse list.  If more than one file is selected the 
file name box will contain "...Multiple Files Selected...".  To select more than one file, hold down the 
SHIFT or CTRL key on the keyboard and then click on the files you wish to import. 

 The line of text below the File Name is an example of how the file should look.  If this is not how the file 
to be imported is formatted, the options in the bottom half of the screen will need to be used to adjust 
the import format. 

 Select OK to start the import of the Form 132 data. 

 Note: the most recent successful import profile will be saved and retrieved the next time import is 
selected. 

 To import a single business's Form 132 information, please see Form 132 Importing. 
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Data Formats for Multiple Business Form 132 Imports 
 
Delimited Text (ASCII) 
Fixed Width Text (ASCII) 
Microsoft Access 2.0, 97 
Microsoft Excel 3.0, 4.0, 97 
Lotus wks, wk1, wk3, wk4 
Federal Diskette (128 Byte) 
Federal Diskette (275 Byte) 
MMREF-1 (512 byte) 
Paradox 3.x, 4.x, 5.x 
dBase III, IV 
FoxPro 2.0, 2.5, 2.6, 3.0 
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ASCII Delimited Text (Multiple Business Form 132 Import) 

 Enter the name of the file to import or press the Browse button and select the desired file.  

 If the filename ends with ".txt", the first 3 lines of the file (preview) should be displayed in the list in the 
middle of the form. 

 

 
 
 Choose the order of how the fields will be imported. 

 Using the mouse, click on the heading of the different fields and drag them to the correct position for 
importing the text file. 

 The order of the Business ID, Year, Quarter, SSN, Last Name, First Name, Middle Initial, Hours, and Wages 
Paid should match the order in which they appear in the delimited text file (See the preview list). 

 To exclude non-required fields from being imported, remove the checkmark in the box below the field 
name by placing the cursor in the desired column and clicking or by pressing the Delete key on the 
keyboard.  To reselect the fields, click in the check box again, or press the Insert key on the keyboard. 

 Only the non-required fields (Middle Initial, Hours and Wages) may be excluded. 

 The Field Separator is the character that divides the fields in the text file.  The default field separator is 
the comma. 

 The Field Delimiter is the character that encloses the fields in the text file.  The default field delimiter is 
the double quote.  The field delimiter can be left blank which means there is no delimiter in the file. 

 The Delimiters on Numbers check box indicates that the numeric fields (hours and wages) are also 
enclosed by the Field Delimiter.  The default is not checked, which means the numbers do not have 
delimiters.  

 The Implicit Decimal in Wages check box indicates that no decimal point is present in the wages and 
the program is to assume two decimal places.  This allows the wages to be stored without decimal point.  
The default is unchecked, which indicates that the decimal point is present in the file.  

 
 When all options are set, click the OK button. 
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 A confirmation of completion should be received.  If not, correct specified errors and try again. 

Fixed Width Text (Multiple Business Import) 

 Enter the name of the file to import or press the Browse button and select the desired file (multiple files 
may be selected when using Browse).  

 
 If the filename ends with ".txt", the first 3 lines of the file (preview) should be displayed in the list in the 

middle of the form. 
 The size and position options will appear in the grid at the bottom of the Multiple Business Form 132 Data Import 

dialog box.  The field lengths for Fixed Width Text (ASCII) appear under the field names. 

 Using the mouse, click on the heading of the different columns and drag them to the correct position for 
importing the text file. 

 The order of the Business ID, Year, Quarter, SSN, Last Name, First Name, Middle Initial, Hours, and Wages 
Paid should match the order in which they appear in the fixed width text file (See preview list). 

 In the box below each field name, type in the length of the field in the ASCII text file. 

 To exclude non-required fields from being imported, click on the column heading of the field and press 
the Delete key on the keyboard.  The color of the column heading will change color and the field will not 
be included in the example text line below the File Name field on the screen.  To reselect a field press 
the Insert key on the keyboard while the appropriate column is selected. 

 Only the non-required fields (Middle Initial, Hours and Wages) may be excluded. 

 The Implicit Decimal in Wages check box indicates that no decimal point is present in the wages and 
the program is to assume two decimal places.  This allows the wages to be stored without decimal point.  
The default is unchecked, which indicates that the decimal point is present in the file.  

 
 When all options are set, click the OK button. 

 A confirmation of completion should be received.  If not, correct specified errors and try again. 
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Microsoft Access 2.0, 97 

 

 Enter the name of the file to import or press the Browse button and select the desired file (multiple files 
may be selected when using Browse).  

 Select the table name to be imported from the "Tables" drop list. 
 

 
  

 A list of field names found in the selected table will appear on the bottom of the Multiple Business Form 132  
Data Import dialog box under the heading Import Field. 

 For each field listed on the left, that will be imported, place the cursor in the corresponding field on the 
right. 

 A down arrow will appear on the far right of the field that the cursor is focused on. 

 Place the cursor on the arrow and select the Form 132 field into which the corresponding field on the left 
will be imported. 
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 When all matches are made, click the OK button. 

 A confirmation of completion should be received.  If not, correct specified errors and try again. 



 98

Microsoft Excel 3.0, 4.0, 97 

Lotus wks, wk1, wk3, wk4 

 Enter the name of the file to import or press the Browse button and select the desired file (multiple files 
may be selected when using Browse).  

 Spreadsheets can be imported provided that the expected worksheet is named the same: in all of the 
files, or 'Sheet1' , or the same as the workbook. 

 

 
 

 A list of field names (Column Headings - 1st row of worksheet) found in the selected worksheet will 
appear on the bottom of the Multiple Business Form 132  Data Import dialog box under the heading 
Import Field.   

 For each field listed on the left that will be imported, place the cursor in the corresponding field on the 
right. 

 A down arrow will appear on the far right of the field that the cursor is focused on. 

 Place the cursor on the arrow and select the Form 132 field into which the corresponding field on left will 
be imported. 
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 When all matches are made, Click the OK button.  A completion verification should be displayed.  If an 
error message is received, correct indicated error and try again. 

 

Federal Diskette (128 Byte) 

 
 Enter the name of the file to import or press the Browse button and select the desired file (multiple files 

may be selected when using Browse).  
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 These records should have a uniform 128 character length.  There are four record types: 1E and 2E 
contain employer information, 1S and 2S contain Employee information (Supplemental). 

 See Federal 128 Byte Record Layouts for specific information on how to format the records. 

 NOTE: if the business Name, EIN, and Address information is provided, OTTER can create the 
business information entry when processing a Multiple Business Import.  Otherwise you will be required 
to enter the business information before importing is allowed. 

 When the correct file is selected, Click the OK button.  A completion verification should be displayed.  If 
an error message is received, correct indicated error and try again. 
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Federal Diskette (275 Byte) 

 Enter the name of the file to import or press the Browse button and select the desired file (multiple files 
may be selected when using Browse).  

 

 
 
 These records should have a uniform 275 character length.  There are two record types: E contains 

employer information, S contains Employee information (Supplemental). 

 See Federal 275 Byte Record Layouts for specific information on how to format the records. 

 NOTE: if the business Name, EIN, and Address information is provided, OTTER can create the 
business information entry when processing a Multiple Business Import.  Otherwise you will be required 
to enter the business information before importing is allowed. 

  When the correct file is selected, Click the OK button.  A completion verification should be displayed.  If 
an error message is received, correct indicated error and try again. 
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MMREF-1 (512 Byte) 

 
 Enter the name of the file to import or press the Browse button and select the desired file (multiple files 

may be selected when using Browse).  
 

 
 These records should have a uniform 512 character length.  There are two record types: RE contains 

employer information, RS contains Employee information (State Records). 

 See MMREF-1 512 Byte Record Layouts for specific information on how to format the records. 

 NOTE: if the business Name, EIN, and Address information is provided, OTTER can create the 
business information entry when processing a Multiple Business Import.  Otherwise you will be required 
to enter the business information before importing is allowed. 

 When the correct file is selected, Click the OK button.  A completion verification should be displayed.  If 
an error message is received, correct indicated error and try again. 
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Paradox 3.x, 4.x, 5.x 

dBase III, IV 

FoxPro 2.0, 2.5, 2.6, 3.0 

 Enter the name of the file to import or press the Browse button and select the desired file (multiple files 
may be selected when using Browse).  

 

 
 A list of field names found in the selected file will appear on the bottom of the Multiple Business Form 

132  Data Import dialog box under the heading Import Field.   

 For each field listed on the left that will be imported, place the cursor in the corresponding field on the 
right. 

 A down arrow will appear on the far right of the field that the cursor is focused on. 

 Place the cursor on the arrow and select the Form 132 field into which the corresponding field on left will 
be imported. 
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 When all matches are made, click the OK button.  A completion verification should be displayed.  If an 
error message is received, correct indicated error and try again. 
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Multiple Business Schedule B Importing 
 
 Select Utilities from the File menu on the menu bar. 

 Select Multiple Business Form Imports from Utilities.  This menu item is available when not in edit mode. 

 Select Multiple Business Schedule B Import. 

 The Multiple Business Schedule B Data Import dialog box will appear.   

 
 

 Select the type of file to import from the Data Format list. 

 Note: Multiple files may be selected for import from the Browse list.  If more than one file is selected the 
file name box will contain "...Multiple Files Selected...".  To select more than one file, hold down the 
SHIFT or CTRL key on the keyboard and then click on the files you wish to import. 

 Depending upon what data format is selected; different options will appear at the bottom of the Multiple Business 
Schedule B Data Import dialog box.  For further information, see Data Formats for Multiple Business Schedule B 
Imports. 

 Note:  If this is the first time import has been used, the default data format is Delimited Text (ASCII).  If the import 
has been used previously, the default data format will be the data format of the last successful import. 

 Type in the full path of the file name or select the Browse button on the right side of the dialog box to 
find the correct file to import. 

 The line of text below the File Name is an example of how the file should look.  If this is not how the file 
to be imported is formatted, the options in the bottom half of the screen will need to be used to adjust 
the import format. 

 Select OK to start the import of the Schedule B data. 

 Note: the most recent successful import profile will be saved and retrieved the next time import is 
selected. 



 106

 Note: If errors in the data format/content are determined, no data from the selected file will be imported.  
A maximum of ten (10) errors will be reported before data validation is aborted. 
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Data Formats for Multiple Business Schedule B Imports 
 

Delimited Text (ASCII) 
Fixed Width Text (ASCII) 
Microsoft Access 2.0, Access 97 
Microsoft Excel 3.0, 4.0, 97 
Lotus wks, wk1, wk3, wk4 
Paradox 3.x, 4.x, 5.x 
Dbase III, IV 
FoxPro 2.0, 2.5, 2.6, 3.0 
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Delimited Text (ASCII) 

 Enter the name of the file to import or press the Browse button and select the desired file.  

 If the filename ends with ".txt", the first 3 lines of the file (preview) should be displayed in the list in the 
middle of the form. 

 

 

 Choose the order of how the fields will be imported. 

 Using the mouse, click on the heading of the different fields and drag them to the correct position for 
importing the text file. 

 The order of the Business ID, Year, Quarter,  Date and Amount should match the order in which they appear in 
the delimited text file (See the preview list). 

 The Field Separator is the character that divides the fields in the text file.  The default field separator is 
the comma. 

 The Field Delimiter is the character that encloses the fields in the text file.  The default field delimiter is 
the double quote.  The field delimiter can be left blank which means there is no delimiter in the file. 

 The Delimiters on Numbers check box indicates that the numeric fields (Amount) are also enclosed by 
the Field Delimiter.  The default is not checked, which means the numbers do not have delimiters.  

 The Implicit Decimal in Amount check box indicates that no decimal point is present in the Amount 
and the program is to assume two decimal places.  This allows the Amount to be stored without decimal 
point.  The default is unchecked, which indicates that the decimal point is present in the file.  

 When all options are set, click the OK button. 

 A confirmation of completion should be received.  If not, correct specified errors and try again. 
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Fixed Width Text (ASCII) 

 Enter the name of the file to import or press the Browse button and select the desired file.  

 If the filename ends with ".txt", the first 3 lines of the file (preview) should be displayed in the list in the 
middle of the form. 

 

 
 

 Choose the order of how the fields will be imported and the lengths of each field. 

 The size and position options will appear in the grid at the bottom of the Multiple Business Schedule B Data 
Import dialog box.  The field lengths for Fixed Width Text(ASCII) appear under the field names. 

 Using the mouse, click on the heading of the different columns and drag them to the correct position for 
importing the text file. 

 The order of the Business ID, Year, Quarter, Date and Amount should match the order in which they appear in 
the fixed width text file (See preview list). 

 In the box below each field name, type in the length of the field in the ASCII text file. 

 The Implicit Decimal in Amount check box indicates that no decimal point is present in the Amount 
and the program is to assume two decimal places.  This allows the Amount to be stored without decimal 
point.  The default is unchecked, which indicates that the decimal point is present in the file.   

 When all options are set, click the OK button. 

 A confirmation of completion should be received.  If not, correct specified errors and try again. 
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Microsoft Access 2.0, 97 

 Enter the name of the file to import or press the Browse button and select the desired file.  

 Select the table name to be imported from the "Tables" drop list. 
 

 
 
 A list of field names found in the selected table will appear on the bottom of the Multiple Business Schedule B 

Data Import dialog box under the heading Import Field. 

 For each field listed on the left that will be imported, place the cursor in the corresponding field on the 
right. 

 A down arrow will appear on the far right of the field that the cursor is focused on. 

 Place the cursor on the arrow and select the Schedule B field into which the corresponding field on the 
left will be imported. 
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 When all matches are made press the OK button. 

 A confirmation of completion should be received.  If not, correct specified errors and try again. 
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Microsoft Excel 3.0, 4.0, 97 

Lotus wks, wk1, wk3, wk4 

 
 Enter the name of the file to import or press the Browse button and select the desired file.  

 Select the worksheet name to be imported from the "Worksheets" drop list. 
 

 
 

 A list of field names (Column Headings - 1st row of worksheet) found in the selected file will appear on 
the bottom of the Multiple Business Schedule B Data Import dialog box under the heading Import 
Field.   

 For each field listed on the left that will be imported, place the cursor in the corresponding field on the 
right. 

 A down arrow will appear on the far right of the field that the cursor is focused on. 

 Place the cursor on the arrow and select the Schedule B field into which the corresponding field on the 
left will be imported. 
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 Press the OK button. 

 A completion verification should be displayed.  If an error message is received, correct indicated error 
and try again. 
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Paradox 3.x, 4.x, 5.x 

dBase III, IV 

FoxPro 2.0, 2.5, 2.6, 3.0 

 Enter the name of the file to import or press the Browse button and select the desired file.  

  
 A list of field names found in the selected file will appear on the bottom of the Multiple Business 

Schedule B Data Import dialog box under the heading Import Field.   

 For each field listed on the left that will be imported, place the cursor in the corresponding field on the 
right. 

 A down arrow will appear on the far right of the field that the cursor is focused on. 

 Place the cursor on the arrow and select the Schedule B field into which the corresponding field on left 
will be imported. 
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 Press the OK button. 

 A completion verification should be displayed.  If an error message is received, correct indicated error 
and try again. 
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Multiple Business Form OQ Importing 
 
 Select Utilities from the File menu on the menu bar. 

 Select Multiple Business Form Imports from Utilities.  This menu item is available when not in edit mode. 

 Select Multiple Business Form OQ Import. 

 The Multiple Business Form OQ Data Import dialog box will appear.   

 

 Select the type of file to import from the Data Format list. 

 Depending upon what data format is selected, different options will appear at the bottom of the Multiple 
Business Form OQ Data Import dialog box.  For further information, see Data Formats for Multiple Form 
OQ importing. 

 Note:  If this is the first time import has been used, the default data format is Delimited Text (ASCII).  If the import 
has been used previously, the default data format will be the data format of the last successful import. 

 Type in the full path of the file name or select the Browse button on the right side of the dialog box to 
find the correct file to import. 

 Select OK to start the import of the Form OQ data. 

 Note: the most recent successful import profile will be saved and retrieved the next time import is 
selected. 

 Note: If errors in the data format/content are determined, no data from the selected file will be imported.  
A maximum of ten (10) errors will be reported before data validation is aborted.  

 
 To Import a single business's Form OQ information, please see Form OQ Importing. 
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Data Formats for Multiple Form OQ importing 
 
Delimited Text (ASCII) 
Fixed Width Text (ASCII) 
Microsoft Access 2.0, Access 97 
Microsoft Excel 3.0, 4.0, 97 
Lotus wks, wk1, wk3, wk4 
Paradox 3.x, 4.x, 5.x 
Dbase III, IV 
FoxPro 2.0, 2.5, 2.6, 3.0 
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Delimited Text(ASCII) 

 Enter the name of the file to import or press the Browse button and select the desired file.  

 If the filename ends with ".txt", the first 3 lines of the file (preview) should be displayed in the list in the 
middle of the form.  

 
 Choose the order of how the fields will be imported. 

 Using the mouse, click on the heading of the different fields and drag them to the correct position for 
importing the text file. 

 The order of the fields should match the order in which they appear in the delimited text file (See the preview list). 

 To exclude non-required fields from being imported, remove the checkmark in the box below the field 
name by placing the cursor in the desired column and clicking or by pressing the Delete key on the 
keyboard.  To reselect the fields, click in the check box again, or press the Insert key on the keyboard. 

 Only the non-required fields may be excluded. 

 The Field Separator is the character that divides the fields in the text file.  The default field separator is 
the comma. 

 The Field Delimiter is the character that encloses the fields in the text file.  The default field delimiter is 
the double quote.  The field delimiter can be left blank which means there is no delimiter in the file. 

 The Delimiters on Numbers check box indicates that the numeric fields are also enclosed by the Field 
Delimiter.  The default is not checked, which means the numbers do not have delimiters.  

 The Implicit Decimal in Amounts check box indicates that no decimal point is present in the dollar 
amount fields and the program is to assume two decimal places.  This allows the dollar amounts to be 
stored without decimal point.  The default is unchecked, which indicates that the decimal point is present 
in the file. 

 When all options are set, click the OK button. 
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 A confirmation of completion should be received.  If not, correct specified errors and try again. 
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Fixed Width Text (ASCII) 

 Enter the name of the file to import or press the Browse button and select the desired file.  
 If the filename ends with ".txt", the first 3 lines of the file (preview) should be displayed in the list in the 

middle of the form.  
 

 
 

 Choose the order of how the fields will be imported and the lengths of each field. 

 The size and position options will appear in the grid at the bottom of the Multiple Business Form OQ Data 
Import dialog box.  The field lengths for Fixed Width Text(ASCII) appear under the field names. 

 Using the mouse, click on the heading of the different columns and drag them to the correct position for 
importing the text file. 

 The order of the fields should match the order in which they appear in the fixed width text file (See preview list). 

 In the box below each field name, type in the length of the field in the ASCII text file. 

 To exclude non-required fields from being imported, click on the column heading of the field and press 
the Delete key on the keyboard.  The color of the column heading will change.  To reselect a field press 
the Insert key on the keyboard while the appropriate column is selected. 

 Only the non-required fields may be excluded.  The Business ID, Year, and Quarter are required. 

 The Implicit Decimal in Amounts check box indicates that no decimal point is present in the dollar 
amount fields and the program is to assume two decimal places.  This allows the dollar amount fields to 
be stored without decimal point.  The default is unchecked, which indicates that the decimal point is 
present in the file. 

 When all options are set, click the OK button. 

 A confirmation of completion should be received.  If not, correct specified errors and try again. 
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Microsoft Access 2.0, 97 

 
 Enter the name of the file to import or press the Browse button and select the desired file.  

 Select the table name to be imported from the "Tables" drop list. 
  

  

 A list of field names found in the selected table will appear on the bottom of the Multiple Business Form OQ 
Data Import dialog box under the heading Import Field. 

 For each field listed on the left that will be imported, place the cursor in the corresponding field on the 
right. 

 A down arrow will appear on the far right of the field that the cursor is focused on. 

 Place the cursor on the arrow and select the Form OQ field into which the corresponding field on left will 
be imported. 
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 When all matches are made press the OK button. 

 A confirmation of completion should be received.  If not, correct specified errors and try again. 
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Microsoft Excel 3.0, 4.0, 97 

Lotus wks, wk1, wk3, wk4 

 
 Enter the name of the file to import or press the Browse button and select the desired file.  

 Select the worksheet name to be imported from the "Worksheets" drop list. 
 

 
 

 A list of field names (Column Headings - 1st row of worksheet) found in the selected file/worksheet will 
appear on the bottom of the Multiple Business Form OQ Data Import dialog box under the heading 
Import Field.   

 For each field listed on the left that will be imported (it is not necessary to use all columns in a 
worksheet), place the cursor in the corresponding field on the right. 

 A down arrow will appear on the far right of the field that the cursor is focused on. 

 Place the cursor on the arrow and select the Form OQ field into which the corresponding field on left will 
be imported. 
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 Press the OK button. 

 A completion verification should be displayed.  If an error message is received, correct indicated error 
and try again. 
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Paradox 3.x, 4.x, 5.x 

dBase III, IV 

FoxPro 2.0, 2.5, 2.6, 3.0 

 
 Enter the name of the file to import or press the Browse button and select the desired file.  

  
 A list of field names found in the selected file will appear on the bottom of the Multiple Business Form 

OQ Data Import dialog box under the heading Import Field.   

 For each field listed on the left that will be imported, place the cursor in the corresponding field on the 
right. 

 A down arrow will appear on the far right of the field that the cursor is focused on. 

 Place the cursor on the arrow and select the Form OQ field into which the corresponding field on left will 
be imported. 
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 Press the OK button. 

 A completion verification should be displayed.  If an error message is received, correct indicated error 
and try again. 
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How to Export Data from a Form 132 
 Select the Form 132 of the Business and Year/Quarter from which you wish to export data. 

 Select Utilities from the File menu on the menu bar. 

 Select Export Form 132 Data from Utilities. 

 The Export Form 132 Data dialog box will appear. This menu item is only available when a quarter or a Form 132 
is selected from the outline on the left panel of the screen. 

  

 Select the Data Format in which to export the file. 

 Enter the full path of the text file, or press the Browse button to select the file into which the Form 132 
data will be exported. 

 Select OK to export the file. 

 If the file exported successfully the message "All records exported" will be displayed.  Select OK.  If the file did not 
export successfully, an error message will be displayed. 
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Federal 128 Byte Record Layouts 
 Fields that are required by the Oregon Employment Department are marked with an asterisk (*) 
and are underlined for ease of identification. 
 
Record layout for Employer Records - Code 1E and 2E (Employer Data) 
 
 These records identify the employer whose employee wage information is being reported.  Each Code 
1E record must be followed directly by a Code 2E record. 
 Following each set of Code 1E/2E records, group together all the employee (Code 1S/2S) records for the 
employer identified in the set of Code 1E/2E records. 
  

Code 1E - Employer Record 
 

Location Field Length Description and Remarks 
*1-2 Record Identifier 2 Constant "1E" 
3-6 Payment Year 4 Enter the year for which the report is being 

prepared. 
7-15 Employer  9 Enter the numeric characters only.  Omit all  
 Identification  prefixes and suffixes.  Do not begin number with  
 Number (EIN)  "69".  OTTER requires this to be able to create 

the business information. 
16-24 State/Locate 69 Number 9 If not applicable enter blanks (spaces). 
25-74 Employer Name 50 Left justify and fill with spaces. 
75-114 Street Address 40 Left justify and fill with spaces. 
115 Foreign Address 1 Enter a space. 
116-128 Blank 13 Enter spaces.  Reserved for SSA use. 
 

Code 2E - Employer Record 
 

Location Field Length Description and Remarks 
*1-2 Record Identifier 2 Constant "2E" 
3-27 City 25 Left justify and fill with spaces.  If foreign address, 

also include the name of the foreign "state", 
province. 

28-37 State 10 Use a standard FIPS postal abbreviation.  For a 
foreign address, enter spaces. 

38-42 Zip Code Extension 5 Use this field as necessary for the four-digit 
extension of the ZIP Code, being sure to include the 
hyphen in position 38. 

43-47 Zip Code or  5 Enter a valid Zip Code.  If foreign use foreign postal  
 Foreign Postal Code  code. 
*48 Name Code 1 Preferred - Enter "S" if the surname appears first in 

the name field (position 12-38) of the following 
Code 1S record(s). 

49 Type of Employment 1 Enter the appropriate Code: 
A - Agriculture 
H - Household 
M - Military 
Q - Medical Qualified Government 

Employment (MQGE) 
X - Railroad 
R - Regular (all others) 

50-51 Blank 2 Enter spaces.  Reserved for SSA. 
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52-55 Establishment number 4 Enter either Establishment number or the Coverage  
 or Coverage Group (CG) Group/Payroll Record Unit number, whichever is  
 /Payroll Record Unit (PRU) applicable, otherwise fill with spaces. 
56 Limitation of Liability 4 For section 218 State/Local entities only:  If  
 indicator  applicable, enter the letter "L".  Otherwise enter a 

  space. 
57-128 Blank 72 Enter spaces.  Reserved for SSA use. 

 
 NOTE: if the business Name, EIN and Address information is provided, OTTER can create the business 
information entry when processing a Multiple Business Import.  Otherwise you will be required to enter the 
business information before importing is allowed. 
 
Record Layout for Employee Wage Record - Code 1S and 2S (Employee Data) 
 
 These records are used to report wage information for the employees of the employer identified in the 
most recent set of Code 1E/2E records.  Each Code 1S record must be followed directly by a Code 2S 
record for the same employee. 
 
 The format of the employee name on the Code 1S record must correspond to the Name Code in position 
48 of the related Code 2E employer record.  Upper case letters are preferred. 
 
 The fields required by the Oregon Employment Department in Code 1S/2S records are identified with an 
asterisk (*) and are underlined for convenience. 
 

Code 1S - Supplemental (Employee) Record 
 

Location Field Length Description and Remarks 
*1-2 Record Identifier 2 Constant "1S" 
*3-11 Social Security Number 9 Enter the employee's social security number. 
*12-38 Employee Name 27 Enter the employee's name.  If Name Code is "F",  

enter First Name(preferred) or initial, Middle Name 
or Initial(preferred), surname.  If Name Code is 
"S"(preferred), enter Surname, First 
Name(preferred) or initial, Middle Name or 
Initial(preferred).  Left justify and fill with spaces. 

39-78 Street Address 40 Left justify and fill with spaces. 
79-103 City 25 Left justify and fill with spaces. 
104-113 State 10 Enter the standard FIPS postal alphabetical 

abbreviation.  Left justify and fill with spaces. 
114-118 Zip Code Extension 5 Use this field as necessary for the four digit 

extension of the Zip Code, being sure to include the 
hyphen in position 114.  Left justify and fill with 
spaces.  If this field is not applicable, enter spaces. 

119-123 Zip Code or 5 Enter a valid Zip Code.  For a foreign address, use 
Foreign Postal Code  this field for the Foreign Postal Code.  Left justify 
and   fill with spaces. 

124 Blank 1 Enter a space. 
*125-126 State Code 2 If the wages are Oregon wages, enter "41". 
127-128 Optional Code 2 To be defined by individual states. 
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Code 2S - Supplemental (Employee) Record 
 

Location Field Length Description and Remarks 
*1-2 Record Identifier 2 Constant "2S" 
*3-9 State Employer 7 Enter 7 digit Business Identification Number (BIN).  

 Account Number  Do not include the hyphen and check digit, e.g., if 
   your BIN is 0123456-7, enter 0123456.  Left Justify 
   and fill with spaces. 

10-14 Blank 5 Enter spaces or for employer use. 
*15-18 Reporting Period 4 Enter the last month and year for the calendar 

quarter for which this report applies as follows: 
Jan-March of 1999 =  "0399" 
April-June of 1999 =  "0699" 
July-Sep of 1999 =  "0999" 
Oct - Dec of 1999 =  "1299" 

*19-27 State Quarterly 9 Employee Wages for quarter. 
 Unemployment  Right justify and zero fill. 
 Insurance Total Wages 
28-36 State Quarterly 9 Right justify and zero fill. 
37-38 Number of weeks worked 2 Numeric only, right justify and zero fill; e.g., 01-13. 
39-42 Date First Employed 4 Enter month and year, e.g., "0198". 
43-46 Date of Separation 4 Enter month and year, e.g., "0199". 
47-51 Taxing Entity code 5 To be defined by user. 
52-53 State Code 2 Enter FIPS postal Numeric Code.  
54-62 State Taxable Wages 9 Right justify and zero fill. 
63-70 State Income Tax Withheld 8 Right justify and zero fill. 
*71-73 Number of Hours Worked 3 Enter the number of hours worked (0-999) during 

the reporting period.  Right justify and zero fill. 
74-80 Other State Data 7 To be defined by the individual agencies. 
81 Tax Type Code 1 Enter the appropriate Code for entries in position 

87-95 and 96-102: 
C - City Income Tax 
D - County Income Tax 
E - School District Income Tax 
F - Other Income Tax 

82-86 Taxing Entity Code 5 To be defined by individual taxing agencies. 
87-95 Local Taxable Wages 9 To be defined by individual taxing agencies. 
96-102 Local Income Tax 7 To be defined by individual taxing agencies. 
103-109 State Control number 7 Optional. 
*110-118 Social Security Number 9 Enter the employee's social security number. 
119-128 Blank 10 Enter spaces or for employer's use.  
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Federal 275 Byte Record Layouts 
 
 Fields that are required by the Oregon Employment Department are marked with an asterisk (*) 
and are underlined for ease of identification. 
 
 
Record layout for Employer Records - Code E (Employer Data) 
 
 This record identifies an employer whose employee wage data is reported.  Generate a new Code E 
record each time it is necessary to change the information in any field on this record.  Following each Code E 
record, group together all the Code S records for the employer identified in that Code E record. 
 

Code E - Employer Record 
 

Location Field Length Description and Remarks 
*1 Record Identifier 1 Constant "E" - Generate a new Code E record 

whenever the information in any field on this record 
needs to be changed. 

2-5 Payment Year 4 Enter the year for which the report is being 
prepared.  Enter numeric characters only.  Update 
each year.  Note: all Code E records within a file 
must be for the same year. 

6-14 Employer Identification 9 Enter only numeric characters.  Omit all hyphens,  
 Number (EIN)  prefixes and suffixes.  This number should NOT 
   begin with '69'.  OTTER requires this to be able to 

create the business information. 
15-23 State/Local 69 Number 9 If not applicable, enter spaces. 
24-73 Employer Name 50 Left justify and fill with spaces. 
74-113 Street Address 40 Left justify and fill with spaces. 
114-138 City 25 Left justify and fill with spaces.  If this is a foreign 

address, also include the name of the foreign 
"state", province, etc., e.g., Ontario. 

139-148 State 10 Use the standard FIPS postal abbreviation.  If this is 
a foreign address, enter the two character country 
code, e.g., CN for Canada.  Left justify and fill with 
spaces. 

149-153 Zip Code Extension 5 Use as necessary for the four-digit extension of the 
Zip Code, being sure to include the hyphen in 
position 149.  If this is a foreign address, use this 
field as necessary for overflow for a foreign postal 
code begun in positions 154-158; left justify and fill 
with spaces.  If field is not applicable, enter spaces. 

154-158 Zip Code or 5 Enter a valid ZIP Code.  For a foreign address, use  
 Foreign Postal Code  this field for the Foreign Postal Code, if applicable; 
   left justify and fill with spaces; if necessary, 

continue the Foreign Postal Code in positions 149-
153 above. 

*159 Name Code 1 Preferred - Enter "S" if the surname appears first in 
the employee name field (positions 11-37) of the 
following Code S records.  Enter "F" if the first 
name appears first in the employee name field of 
the following Code S records.  this code may vary 
with each Code E record as long as the name 
format on the associated Code S records remains 
consistent with this name code. 
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160 Type of Employment 1 Enter the appropriate code: 
A - Agriculture 
H - Household 
M - Military 
Q - Medicare Qualified Government Employment 
X - Railroad Employment 
R - Regular (All others) 

161-162 Blocking Factor 2 Maximum blocking factor = 25 
163-166 Establishment Number 4 Enter the Establishment Number of the Coverage 
 or Coverage Group/  Group/Payroll Record Unit number, whichever is  
 Payroll Record Unit  applicable.  Otherwise enter spaces. 
167-254 Blank 88 Enter spaces.  Reserved for SSA use. 
255 Limitation of Liability 1 If applicable, enter the letter "L".  Otherwise, enter  
 Indicator  a space. 
256 Foreign Address 1 If the information shown in positions 74-158 is for a  
 Indicator  foreign address (i.e., outside of the US and US  
   territories and possessions, and not APO or FPO), 
   enter the letter "X" in this field.  Otherwise, enter a  
   space. 
257-275 Blank 19 Enter spaces.  Reserved for SSA use. 
 
 
Record Layout for Supplemental Record - Code S (Employee Data) 
 
 This record is used to report quarterly wage data for individual employees of the employer 
identified in the previous Code E record.  Code S records should be grouped together to follow the 
appropriate Code E record.  The employee wage records may appear in sequence by SSN or Name 
within each Code E record. 
 
 The format of the employee name in the Code S record must correspond to the Name Code 
indicated in position 159 of the Code E record.  Separate all segments of the name with spaces.  Upper 
Case letters are preferred. 
 

Code S - Supplemental (Employee Data) Record 
 
Location Field Length Description and Remarks 
*1 Record Identifier 1 Constant "S" 
*2-10 Social Security Number 9 Enter the employee's social security number. 
*11-37 Employee Name 27 Enter employee's name.  If Name Code in position 

159 of Code E record is "S", enter Surname, first 
name, middle initial.  If Name Code is "F", enter 
First name, middle initial, Surname.  Left justify and 
fill with spaces. 

38-77 Street Address 40 Left justify and fill with spaces. 
78-102 City 25 Left justify and fill with spaces.  If this is a foreign 

address, also include the name of the foreign 
"state", province, etc. e.g., Ontario. 

103-112 State 10 Enter the standard FIPS postal alphabetical 
abbreviation.  If this is a foreign address, enter the 
two-character country code, e.g., CN for Canada.  
Left justify and fill with spaces. 

113-117 ZIP Code Extension 5 Use this field as necessary for the four-digit 
extension of the ZIP Code, being sure to include the 
hyphen in position 113.  If this field is not 
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applicable, enter spaces. 
118-122 ZIP Code or 5 If this is a foreign address, use the field for the  
 Foreign Postal Code  Foreign Postal Code, if applicable.  Left justify and 

fill with spaces.  If necessary, continue the Foreign 
Postal Code in positions 113-117.  Otherwise, enter 
a valid ZIP Code. 

123 Blank 1 Enter a space. 
*124-125 State Code 2 If the wages are Oregon wages, enter "41". 
126-127 Optional Code 2 To be defined by individual states. 
*128-131 Reporting Period 4 Enter the last month and year for the calendar 

quarter for which this report applies; e.g., "0399" for 
January - March of 1999. 

*132-140 State Quarterly 9 Employee Wages for quarter. 
 Unemployment  Right justify and zero fill. 
 Insurance Total Wages 
141-149 State Quarterly 9 Right Justify and zero fill. 
 Unemployment 
 Insurance Total Wages 
150-151 Number of Weeks 2 Enter the appropriate number of weeks worked  
 Worked  (0-13) during the reporting period.  Right justify and 

zero fill. 
152-155 Date First Employed 4 Enter the month and year, e.g., "0198" 
156-159 Date of Separation 4 Enter the month and year, e.g., "0199" 
160-164 Taxing Entity Code 5 To be defined by user. 
*165-171 State Employer 7 Enter your 7 digit Business Identification Number  
 Account Number  (BIN).  Do not include the hyphen and check digit,  

e.g., if your BIN is 0123456-7, enter 0123456. 
172-182 Blank 11 Enter spaces or for employer use. 
183-184 State Code 2 Enter appropriate FIPS postal numeric code. 
185-193 State Taxable Wages 9 Right justify and zero fill. 
194-201 State Income Tax 8 Right justify and zero fill. 
 Withheld 
*202-204 Number of Hours 3 Enter the number of hours worked (0-999) during 
 Worked  the reporting period.  Right justify and zero fill. 
205-211 Other State Data 7 To be defined by individual taxing agencies. 
212 Tax Type Code 1 Enter the appropriate code for entries in fields 218-

226 and 227-233. 
C - City Income Tax 
D - County Income Tax 
E - School District Income Tax 
F - Other Income Tax 

213-217 Taxing Entity Code 5 To be defined by individual taxing agencies. 
218-226 Local Taxable Wages 9 To be defined by individual taxing agencies. 
227-233 Local Income Tax 7 To be defined by individual taxing agencies. 
 Withheld 
234-240 State Control Number 7 Optional. 
241-275 Blank 35 Enter spaces or for employer use. 
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MMREF-1 (512 Byte) 

CODE RE – EMPLOYER RECORD LAYOUT - Length = 512 
 
The fields required by the Oregon Employment Department are identified with an asterisk (*) and are 
underlined for your convenience.  Fields that are in Italics are fields that are preferred but are not required. 
 
Location Field Length Specifications 
*1 – 2 Record Identifier 2 Constant "RE" 
3 – 6 Tax Year 4 Not required. 
7 Agent Indicator Code 1 Not required. 
8 –16 Employer/Agent 9 Not required. 
17-25 Agent for EIN 9 Not required. 
26 Terminating Business Indicator 1 Not required. 
27-30 Establishment Number  4 Not required. 
31-39 Other EIN 9 Not required. 
40-96 Employer Name 57 Enter the employer's business name as 

registered with the Oregon Employment 
Department.  Left justify and fill with blanks. 

97-118 Physical Address 22 Not required. 
119-140 Delivery Address 22 Enter the employer's delivery address (street or 

post office box).  Left justify and fill with blanks. 
141-162 City 22 Enter the employer's city.  Left justify and fill with 

blanks. 
163-164 State Abbreviation 2 Enter the employer's state.  Use a postal 

abbreviation.  For a foreign address, leave blank. 
165-169 Zip Code 5 Enter a valid zip code.  For a foreign address, 

leave blank. 
170-173 Zip Code Extension 4 Enter the four-digit extension of the zip code.  If 

not applicable, leave blank. 
174-178 Blank 5 Not required. 
179-201 Foreign State Province 23 Not required. 
202-216 Foreign Postal Code 15 Not required. 
217-218 Country Code 2 Not required. 
219 Employment Code 1 Not required. 
220 Tax Jurisdiction Code 1 Not required. 
221-512 Blank 292 Spaces. 
 

CODE RS – STATE RECORD LAYOUT  - Length = 512 
 
The fields required by the Oregon Employment Department are identified with an asterisk (*) and are 
underlined for your convenience.  Fields that are in Italics are fields that are preferred but are not required. 
 
Location Field Length Specifications 
*1 – 2 Record Identifier 2 Constant "RS" 
*3 – 4 State Code 2 Enter the appropriate FIPS postal Numeric code.  

For Oregon, the code is "41". 
 5 – 9 Taxing Entity Code 5 Not required. 
*10-18 Social Security Number(SSN) 9 Enter the employee's social security number. 

Enter only NUMERIC characters.  If the SSN is 
not available, enter zeros (0) in locations 10-18.  
Omit Hyphens, prefixes and suffixes.  DO NOT 
USE 111111111, 333333333, OR 123456789. 

*19-33 Employee First Name 15 Enter the first name of the employee exactly as 
shown on the social security card.  Left justify and 
fill with blanks. 

*34-48 Employee Middle Name 15 If applicable, enter the employee's middle name 
or initial exactly as shown on the social security 
card. Left justify and fill with blanks. 
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*49-68 Employee Last Name 20 Enter the last name of the employee exactly as 
shown on the social security card.  Left justify and 
fill with blanks. 

69-72 Suffix 4 Not required. 
73-94 Location Address 22 Not required. 
95-116 Employee Address 22 Enter the employee's address.  Left justify and fill 

with blanks. Not required but preferred. 
117-138 Employee City 22 Enter the employee's city.  Left justify and fill with 

  blanks. Not required but preferred. 
139-140 State Abbreviation 2 Use the appropriate state 2 digit abbreviation.  

For a foreign address, leave blank. Not required 
but preferred. 

141-145 Zip Code 5 Enter the appropriate valid zip code.  For a 
foreign address, leave blank. Not required but 
preferred. 

146-149 Zip Code Extension 4 Use this field for the four-digit extension of the Zip 
Code.  If not applicable, leave blank. Not required 
but preferred. 

150-154 Blank 5 Spaces. 
155-177 Foreign State Province 23 Not Required. 
178-192 Foreign Postal Code 15 Not Required. 
193-194 Country Code 2 Not Required. 
195-196 Optional Code 2 Not Required. 
 
*197-202 Reporting Period 6 Enter the last month and 4 digit year in MMCCYY 

format for the calendar quarter for which this 
report applies; e.g., "032001" for January-March 
of 2001. 

 
*203-213 State Quarterly Unemployment 11 Right justify and zero fill.  Do not include commas 
 Insurance Total Wages  or decimals.  Negative amounts are not allowed.  
 
214-224 State Quarterly Unemployment 11 Not Required. 
 Insurance Total Taxable Wages 
 
225-226 Number of Weeks Worked 2 Not Required. 
227-234 Date First Employed 8 Not Required. 
235-242 Date of Separation 8 Not Required. 
 
243-247 Blank 5 Not Required. 
*248-254 State Employer Account 7 Business Identification Number.  Do not include 
 Number  hyphen or check digit, e.g., if BIN is 0123456-7, 

enter  0123456. 
255-267 Blank 13 Not Required. 
268-273 Blank 6 Not Required. 
274-275 State Code 2 Not Required. 
276-286 State Taxable Wages 11 Not Required. 
 
287-297 State Income Tax Withheld 11 Not Required. 
298-307 Other State Data 10 Not Required. 
308 Tax Type Code 1 Not Required. 
309-319 Local Taxable Wages 11 Not Required. 
320-330 Local Income Tax Withheld 11 Not Required. 
331-337 State Control # 7 Not Required. 
*338-340 Hours Worked 3 If hours worked is greater than 999, enter 999.  

Do not enter partial hours.  Right justify and zero 
fill. 

341-412 Supplemental Data 72 Not Required. 
413-487 Supplemental Data 75 Not Required. 
488-512 Blank 25 Not Required. 
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Search 
How to Search for Information 

 Select Search from the List menu or from the toolbar. 

 The Search dialog box will appear. 

  

 Select the Name button on the bottom of the dialog box to sort the list of businesses by name. The last 
selected order will be retrieved the next time search is selected. 

 To search for a particular business by name, type the first letter of the business's name. 

 The list of names will change to find the closest match to what has been typed. 

 Select the Business ID button on the bottom left side of the dialog box to sort by the Business ID 
numbers (BIN). 

 To search for a particular business by ID number (BIN), start typing the business ID (BIN). 

 The list of IDs will change to find the closest match to what has been typed. 

 Click on a business name or ID number (BIN). 

 The corresponding years for the selected business will appear to the right in the Year section of the dialog box. 

 Select the year to be found. 

 The corresponding quarters for the selected year will appear below the Year section, in the Quarter section of the 
dialog box. 

 Select the quarter to be found. 

 Select the OK button to start the search. 

 Select the Cancel button to cancel the search. 
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Sort  
How to Change the Sort Order of the Businesses 
Changing the sort order will change the way the outline in the left panel of the main screen is sorted. 

 Select Sort from the List menu or from the toolbar. 

 The Sort dialog box will appear. 

  

 Select either Name or Business ID number (BIN) from the drop down Business list. 

 Select either Ascending or Descending for Business ID or name. 

 Select Ascending or Descending for the year. 

 Select Ascending or Descending for the quarter. 

 Select the OK button to make the sort changes effective. 

 Select the Cancel button to cancel the sort changes. 
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Amending a Report 
 
If a report sent using this program is in error, the program can be used to amend the report.  An amended 
report is one that contains the correct amounts that should have been on the original report; not the 
differences.   
 
You may use the program to create the amended report, but DO NOT send the amended report 
electronically. 
 
INSTEAD, print the amended report and write AMENDED at the top of each form.  CIRCLE the changes 
made, and include a brief explanation of the changes made.  Send an amended copy of each of the forms 
that was submitted as the original report, even if only one of the forms has a change. 
 
Mail AMENDED REPORT to: 

Employment Department 
Tax Section - OTTER 
875 Union St NE 
Salem OR 97311-0030 

 
 
Mail any PAYMENT required because of the amendment with a Form OTC to: 

Oregon Department of Revenue 
PO Box 14800  
Salem OR 97309-0920 

 
 
If you need help with any adjustments or have questions about creating amended reports, please call the 
Tax Representative in your area. 
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Technical Support 
If you need help with this program and have not found the answer to your question in this instruction booklet, 
you may call the Oregon Employment Department Tax Office in your area. 
 

 
To find your closest Oregon Employment Department Tax Office phone number, go to our web page at 
www.oregon.gov/EMPLOY/TAX and select Tax Offices from the left menu bar. 
 
The Central Office fax number is (503) 947-1487. 
 
Questions may be e-mailed to: taxinfo@emp.state.or.us . 
 
Trademarks:  All brand names and product names used in this book are trademarks, registered trademarks 
or trade names of their respective holders. 

http://www.oregon.gov/EMPLOY/TAX
mailto:taxinfo@emp.state.or.us
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Quick Reference 
 
Bold, Italicized words indicate buttons, fields, or menu items. 
Use the Tab key on the keyboard to step through fields on any screen. 
Use the Shift + Arrow key to select more than one item in a list. 
Use the Ctrl key and mouse to select only certain items in a list. 
 
Cancel Field Changes - Esc 
 
Help Contents  -  F1 
 

   New Business 
 

   Add  
 

   Delete  -  F4 
 

  Save  -  F2 
 

  Copy Quarter  
 

  Validate Quarter - F12 
 

  Print  -  Ctrl+P 
 

  Print Preview - Ctrl+R 
 

  Search  -  F3 
 

  Sort   
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Backup/Archive/Restore Otter Data 
Otter has a built-in backup, archive, and restore features. 
    
Backup feature allows a user to create an exact copy of the current Otter32.mdb file.  
Archive feature allows a user to move old records from the current Otter database file to the “archive” 
database.  
 
The backup copy of the Otter32.mdb and the archive database could be created on a network drive or an 
external drive. 
 
Restore feature allows a user to restore previously archived Otter data. 
 
 
Backup Otter Data 
 

 In Otter, select Backup/Restore option under File menu. The Backup Utilities window will come up. 

 
 

 The grid in the Backup Utilities window shows the Year, Quarter, Business ID and Business Name of 
the businesses that Otter currently has data for. 

To create a backup of the existing database Otter32.mdb: 

 Select Backup under Options, then specify the path and a name for the backup database in the “to:” 
box. By default, the destination database is C:\Program Files\Otter32\otter32Back.mdb. 

You can use the Browse button to navigate to the destination database.  

You can backup Otter database to an external drive. 

 Click on the OK button.  A copy of the database Otter32.mdb should be created in the specified 
directory. 

The utility will generate a message to inform the user of a success or failure of the backup operation, 
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and the reason for failure such as Invalid path or read/write permission problem. 

 The backup grid can sort its contents in ascending or descending orders by clicking on the Year, Qtr, 
and Business ID column headers. 

 

Archive/Restore Otter Data 
Basic concepts of Archive/Restore: 
1. Source database: the database being archived or restored. 

2. Destination database: the database which will receive the records from the Source database. 

3. Source grid: the left grid showing the contents of the Source database. 

4. Destination grid: the right grid showing the contents of the Destination database. 

5. Archive/Restore modes of the Backup Utilities use color coding to identify duplicate records in the source 
and destination databases. Duplicate records appear in red text, and new records are blue. 

6. In the Archive mode the source database is always the currently open Otter database (Otter32.mdb). 
Archiving is designed to reduce the size of Otter database to make it more efficient and faster.  

7. In the Archive mode the user has an option to remove or keep the archived records. However, it is 
recommended to create a backup of the Otter database before archive/remove operation. 

8. In the Restore mode the destination database is always the Otter database (Otter32.mdb). 

9. Data in both, the source grid and the destination grid, could be sorted by Year, Qtr, or Business ID.  

To sort the information in the grid by the column in the ascending order, click on the column heading 
once. Clicking on the column heading again will sort the information in descending order. 
The information in the grid will be sorted by the column that was selected and clicked on. 

10. The source grid has a popup menu for selecting and unselecting its contents. 

11. To select a row in the grid, click on the record selector of that row. The entire row will be highlighted. 

12. To select multiple consecutive rows in the grid, select the first row you would like to select, and while 
holding down the Shift key on the keyboard, select the last row you would like to select. All the rows in 
between will be highlighted 

13. To select all the records in the source grid, right-click in the grid, and select “Select all records” option 
from the menu. To unselect all the records in the source grid, right-click in the grid, and select “Unselect 
all records” option.  

 

Archive Otter Data 
Archive option in Otter allows a user to archive old year’s Otter data. 

 To archive records from the current Otter database, select Archive option, then specify the path and 
database name in the “to:” box. By default, the destination database is C:\Program 
Files\Otter32\otter32Arch.mdb. 

You can use the Browse button to navigate to the destination database.  

 As soon as you select the archive database, the destination grid will show the database contents.  

 In the source grid, select records you would like to archive. 

As soon as you select one or more rows in the left grid, OK button becomes available.  
OK button will remain disabled (grayed-out) if no records are selected in the source grid. 
 

 Put a check mark in the check box ”Remove records from source database after archive is finished” if 
you would like to remove records from the current Otter database. 

 Click on the OK button. 
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Note: the blue color indicates that records did not exist in destination database. 

 Click on the Done button to finish the Archive operation.  
Total number of the archived and duplicate records (if any) will be shown in lower right corner of the 
Backup Utilities window. 

 
Duplicate records 
If records already existed in the destination archive database, they appear in red, and Overwrite and 
Skip buttons become available. 
To update records in the destination database, click on the Overwrite button.  
Clicking on the Skip button allows the user to write the new records into the destination database and 
skip the duplicate records. 
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 To close the Backup Utilities window, click on the Cancel button.  
 
 
Restore Otter Data 
Restore option in Otter allows a user to restore previously archived or backed up Otter data.  

In the Restore mode, the destination database is your current Otter database (Otter32.mdb). 

 In the Backup Utilities window, select Restore option. 

 Click on the Browse button, and select the database to restore Otter data from (e.g. C:\Program 
Files\Otter32\otter32Arch.mdb or :\Program Files\Otter32\otter32Back.mdb). 

 The contents of the source database will be shown in the source grid.  

 In the source grid, select records to be restored. 

As soon as you select one or more rows in the left grid, OK button becomes available. 

 Click on the OK button. 
Selected records will be imported from the source database to the destination database, and will be 
shown in the destination grid.  
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 If any of the selected records already exist in the destination database, you can clicking on the Skip 
button to leave existing records in the intact.  

NOTE: clicking on the Overwrite button will replace existing records in the destination database with 
records from the backup/archive database. Any changes that were done to these records since the 
last backup/archive will be lost! 

 Click on the Done button. 

 Click on the Cancel button to close the Backup Utilities window. 

 
Helpful Hints 
  It is a good idea to run the Database Repair Utility on a regular basis.  This utility has two functions:  1)  

repair corrupted data files, 2) compact the data file.  Compacting the data file makes the database run 
more efficiently and therefore faster. 

 To Backup the Otter information see Backup Otter Data. 

 
Convert/Merge Databases 

 Program name: Convert.exe; located in the \Otter32 folder. 
 

 This utility can be used to convert an Otter.mdb file to an Otter32.mdb or to Merge Otter.mdb or 
Otter32.mdb files. 

 
 To start this program, select the Merge Database Icon from the Start\Programs\Otter32 System Menu in 

Windows 98/2000/XP/Vista.  This will start the program with the destination database pointing to the 
Otter32.mdb file. 
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 Select the Folder and file that you want to convert/merge into the current Otter32.mdb.  Press the Next 
button to start the conversion/merging process.  The results screen will be displayed indicating what 
action is being performed.  When the merging process is finished, the "Merge Complete" message will 
be displayed. 

 You can use Backup/Restore utility to merge Otter data. 
 
 
Database Repair Utility 
 Program name: Repair32.exe; located in the \Otter32 folder. 

 This utility repairs most database corruption problems.  Runtime errors of type 30xx (e.g. 3049) are 
generally corrected by the execution of this utility.  

 This utility also compacts the database making it more efficient and faster. 

 To start this program, select the Repair Database icon from the Start\Programs\Otter32 System menu in 
Windows 98/2000/XP/Vista.  This will start the program with the default database pointing to the 
Otter32.mdb file.  Click the Repair Database button to execute the repair or change the file to be 
repaired by selecting a new file. 



 147

Other Forms 
 

Form OTC - Oregon Combined Tax Payment Coupon.  Form OTCs are mailed separately, by 
December 31 of each year.  If you need to order additional coupons, 

 Write: or Call: 
 Oregon Department of Revenue 503-945-8091 or 
 PO BOX 14800 503-378-4988. 
 Salem  OR 97309-0920 
    

Form 013 - Change in Status Report.  Use this form to report changes in your business.  Do not use 
Form OTC or Form OQ to make changes in status.  See the Change in Status Report for 
detailed instructions.   Form 013 WR is included in Acrobat Reader format on the Otter32 CD 
or may be downloaded from the Oregon Department of Revenue web site 
www.oregon.gov/DOR 

 
Form WR - Oregon Annual Withholding Tax Reconciliation Report.  Use this form to reconcile 

your state withholding account.  Form WR is due February 28 of each year.  Form WR is 
included in Acrobat Reader format on the Otter32 CD or may be downloaded from the 
Oregon Department of Revenue web site www.oregon.gov/DOR. 

 

Guidelines for Oregon withholding payment due dates 

If your federal tax liability is: Oregon withholding tax payments are due: 

• less than $1,000 for the quarter Within 30 days after the end of the quarter 

• $50,000 or less in the lookback period* by the 15th of the month following payroll 

• More than $50,000 in the lookback period* 

If the day falls on a: 
Wednesday, Thursday 
and/or Friday 

Saturday, Sunday, 
Monday, and/or Tuesday 

Semiweekly Deposit Schedule 

Then pay taxes by: 

the following Wednesday 

the following Friday 

• $100,000 in a single pay period* Within one banking day 

*Lookback period is the twelve-month period ended the preceding June 30.  The lookback 
period for agricultural employers is the calendar year prior to the calendar year just ended. 

 
Credit Balance Handling 
 
Note: You cannot use Form OQ to transfer credits between programs. 
 
 Credit applied to another program: 

 Send a written request along with Form OQ to the agency who handles the program 
that has the credit. 

 Include your account name, BIN, tax program, quarter, and year where the credit is and 
give the same information for where you want the credit applied.  Also include any 
notices or memos you've received regarding the credit. 

 
 Credit refunded: 

Send a written request to the agency who handles the program that has the credit.  Include your account 
name, BIN, the work "Refund," and the amount to refund. 

http://www.oregon.gov/DOR/
http://www.oregon.gov/DOR/
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